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Note that, in this document, the symbol at left denotes information of particu-
lar importance.❢ ☞
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The Sonic Essentials

Introduction
This document attempts to convey the essential information needed for basic

operation of the SonicStudio. The user manual and other documentation covers
many specific aspects of the Sonic in great detail. However, this general overview
of the Sonic is for those who have gotten past the tutorials and need more infor-
mation, but haven’t the time to digest those user manuals…

Understanding the details requires a basic knowledge of the whole. I’ve tried
to provide that minimum framework that can later be enhanced with practice
and further study. The time and effort devoted to learning the system can only
improve your proficiency and outlook. So, let me know how this document can
be improved and, happy driving!

The Mac & Maintenance
• The Macintosh

Hardware
The SonicStudio is based on a host Macintosh. Therefore, it’s important

to assure that the host is set up properly and working well. It’s also very
important to understand how the computer itself works before you can
expect great things from your SonicStudio. There are several good books
by Peachpit Press and others that can help you brush up on your computer
skills.

First, a quick discussion of the hardware involved. The hardware com-
ponents consist of the Central Processing Unit or CPU, memory for the
processor and a display for it to “express itself.”

The Macintosh CPU belongs to one of two families, CISC or RISC
(Complex/Reduced Instruction Set Computer). All older Macs, such as
the Quadra, Centris and Mac II lines are CISC. The PowerPC PowerMacs
and clones are RISC. In general, RISC is a faster technology because the
overall function is streamlined. Over time, the Sonic is evolving to take
advantage of the new capabilities of these PPC Macs.

Memory is needed for short and long term storage of information in the
computer. The Sonic application should be assigned as much RAM (short
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term memory) as possible. More memory doesn’t make the Sonic go faster,
it simply lets you work with longer, more complex EDLs and bigger video
files without running out of memory. When the Sonic runs out of memory,
you must restart the Mac! More on memory later…

The Mac and it’s Sonic parasite need a display for show and tell. 8 bit or
256 colors are all that’s needed for Sonic. Any more and you’re wasting re-
draw time and money. Of course, Sonic Video should have a separate 13" or
larger NTSC or PAL monitor and display board for the interlocked video.

Software & the Operating System
The Operating System (OS) is the software that make the Mac hard-

ware behave like a Macintosh and not antilock braking system. The OS
resides in the System folder. Since a lean, mean Mac makes for a fast, stable
Sonic System, the Mac should have a custom tailored OS. This prevents
the Mac from choking on needless software in the System Folder.

Several solutions are available to help maintain order in your System
Folder. An excellent 3rd party product, Conflict Catcher from Cassidy &
Green, replaces Apple’s less powerful Extensions Manager with total con-
trol of your system resources. Either will work if your Mac is only used for
Sonic but, for multiple–use CPUs, you may want Conflict Catcher.

In the System Folder is the Apple Menu Items folder. As the name im-
plies, this is where all those things under the Apple Menu “live.” For con-
venience, create an alias of the Sonic System application. Rename it with
the version shown on the install floppies and a leading space before the
name and place in the Apple Menu Items folder. The leading space will
force it to the top of the menu’s list. This alias will allow you to launch the
Sonic System without fumbling about for the application or cluttering the
Desktop with aliases.

Two other occupants of the System folder are the Control Panels and
Extensions folders. These contain small bits of software that modify the
operation of the Mac. While Control Panels are user adjustable, Extensions
are not. As mentioned above, move any unused or questionable items to
the Control Panels (Disabled) or Extensions (Disabled) folder and restart
the computer. This includes all shareware and third party software other
than QuicKeys. If you don’t know where it came from or what it does, then
move it! The QuicKeys control panel should be minimally “Configured”
for Custom (48k) to ensure that enough memory is available to load the
Sonic keyset.

❢ ☞
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• Mac maintenance
Disk Utilities
There isn’t much to maintaining the computer except for common sense

and one or two pieces of third party software. First, the common sense
part. Keep the computer (and Sonic hardware for that matter) well venti-
lated and as dust free as possible. Provide clean AC power and adhere to
accepted grounding practices.

Next, the third party software: Due to the shakeout of the software in-
dustry, the only available 3rd party utility for maintaining the Mac’s disk
structure is Symantec’s Norton Utilities for Mac. Do not install Norton
onto the HFS (Mac) disk, simply build an Emergency boot disk as per the
instruction provided. Another desirable software add-on is a virus protec-
tion package if floppies come in from out of house. Virex is recommended
and the annual subscription service can’t be beat for the price and security
it provides. Be sure to read the accompanying manuals for these 3rd party
products.

Hardware Overview
• The USP hardware

Motorola DSPs
The following discussion focuses on the USP version of Sonic hardware.

The SSP hardware option, though restricted to a lower overall performance,
follows the same basic operating principles.

There are four 56000 series digital signal processors (DSP) on the USP
board. These chips provide the streamlined engine for running the custom
Sonic software. In simple terms, one processor runs the monitor path. An-
other DSP supervises the data flow to and from the attached SCSI devices.
SCSI stands for “Small Systems Computer Interface.” Pioneered by Apple,
it’s a hard and software protocol for using computer peripherals. The two
remaining devices are dedicated, under user control, to getting AES audio
in and out of the Sonic.
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Internal & external communication
The USP board has to communicate with the Mac. The NuBus or PCI

connector provides that path as well as supplying power to the board. In
the Mac’s view of hardware, the physical connectors are organized into
“slots.” Hierarchical numbering of the slots, known as slot ordering, varies
with CPU model. If more than one USP is used in one CPU, then care
must be taken with slot ordering. Please discuss the particulars of your
install with a Sonic representative.

As mentioned above, a USP supervises the data flow to and from all of
the attached SCSI devices. Remember that the USP has its own SCSI bus,
invisible to and separate from the Mac’s SCSI. If the Mac can’t “see it,” it
can’t interrupt things and slow down the whole process. SCSI devices each
require a unique address so they can be addressed or “spoken to” individu-
ally. If two or more devices share the same address, confusion reigns.

As with all high speed bus architectures, SCSI requires termination at
both ends of the bus. Internally, the last physical board in the SCSI chain
should be the only terminated board. Externally, the last SCSI device, usu-
ally a CD Printer or sound disk, should have the other terminator.

The high speed DSPs require a buffer or holding tank for the data going
to and from the slower SCSI devices. This buffer, or “FIFO,” varies in size
depending on what job the USP is required to do. A 48 or 12 MB buffer is
needed for a main board and 3 MB for an FX board. The SCSI transaction
part of the Basic Signal Flow & Processing section, later on, discusses the
implications of this buffer.

The internal path for communication between multiple USPs are the
“board to board ” connectors. These 20 pin connectors and their ribbon
cables allow all of the installed DSPs to share data. These ribbons, carrying
audio data and clock, are always hooked up in a ring even if there is only
one USP.

Figure 1 -
SSP/USP Board to Board

Jumpers
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• AES-1992
A digital audio standard
AES data carries stereo audio and Channel Status or auxiliary data. A

specification, “AES 1992,” describes three configurations, a professional
and two consumer versions. The Digital I/O boxes (Digital I/O-4 & 8)
that attach to the USP provide conversion from the parallel, multichannel
“big audio hose” on the back of the USP to the 2 channel serial AES stan-
dard.

Type I
Type I uses a balanced 110 Ohm XLR3 connector. Being a balanced

circuit, it is quite immune to external interference and, with special, high
quality wiring, can be run up to 300 meters. Unfortunately, because of the
very high frequencies involved, digital audio data does not benefit from a
connector originally designed for audio frequencies. To overcome the high
frequency limitations of XLR connectors and verboten TT patchbays, the
AES–on–XLR signal can be converted to an unbalanced version that uses
BNC connectors on 75 Ohm coaxial cable. This allows you to use the
extensive range of existing video cabling hardware for digital audio inter-
connections as well.

Type II
There is already a standard configuration, seen in budget hardware, us-

ing an unbalanced connection. AES Type II unbalanced is one of two con-
sumer configurations. It uses an RCA connector, which is better suited
than an XLR to the very high frequencies of a digital audio data stream but
falls short in other ways. It is best used for very short cable runs, 3 meters or
less.

The third type of AES is Type II optical. This version uses 5 mm plastic
fiber and is totally immune to external RFI/EMI. The F05 connectors are
often referred to by Toshiba’s “TOSLink” brand name. The maximum
workable length for this version is only 10 meters. This is the connector
type also used on some consumer audio products and the SSP. The AES
Type II optical approach is more prone to jitter than the other two ver-
sions.
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Set Up
• USP hardware

Single or multiple boards
Single USP systems provide 2 to 16 channels of digital I/O. If you

have two or more boards, you can configure the hardware to provide
extended multichannel operation or the extra boards can be used for
dedicated effects (FX) processing. Multiple USPs in any configuration
require specific software options to function.

Two FX boards can provide stereo broadband denoising in real time
or parallel DSP processing (background NoNOISE or background
Sample Rate Conversion) of two mono channels simultaneously. A single
FX board can provide stereo reverb in real time or monaural processing
of other background DSP jobs.

Two to four USPs can be configured for extended multichannel op-
eration. Each additional USP provides an additional 16 channels up a
maximum of 64. Multichannel systems should be installed in conjunc-
tion with 1 MediaNet board for every 2 USPs for best performance.
Multiboard systems require additional hardware to provide a master
clock source for all converters.

MediaNet-enabled multiboard
Multiboard USP systems need MediaNet to realize their full poten-

tial. Sonic high speed networking product, MediaNet provides “cross-
bussed” routing of SCSI data from one board to another for maximum
I/O flexibility. Audio from any line input can then be recorded on any
SCSI chain. In addition, audio from any strip on the mixing desk can
be routed to any line output.

• SCSI devices
Termination
As mentioned above, the SCSI bus requires termination at both ends

of the bus. The last physical USP or MediaNet board in any SCSI chain
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should be the only terminated board. The last external SCSI device,
usually a CD Printer or sound disk, should carry the other terminator.

Addressing
SCSI devices each require a unique address so they can be, strangely

enough, addressed individually. The USP uses ID 7. Dedicated FX
boards (SCSI Slaves) take addresses 6 (mono) and 5 (stereo). Other
devices on the chain, including MediaNet boards,  take whatever IDs
are left down to 0. A MediaNet board also takes an address. So, a Sonic
with stereo FX (three USPs all on the same SCSI bus) uses address 7
through 5. This would leave only ID 0 through 4 for external devices.
Remember, each device must have it’s own address for that chain.

“SCSI Slaves” require special attention. When two or three USPs
share the same SCSI bus via a single SCSI ribbon cable spanning sev-
eral boards, the Sonic treats the second and third board as dedicated FX
boards. They cannot send or receive AES from outside, but they can
perform background DSP without disturbing foreground operations.
If a Sonic is paying the bills with NoNOISE, then the system should be
configured with SCSI Slaves.

Sonic SCSI Maintenance
As with all mechanical devices, your Sonic disks needs annual main-

tenance. A years worth of dust has accumulated inside the enclosure
and the magnetic domains defining the logical volume have weakened.
As far as the dust is concerned, gently blow out any dust. Don’t use a
vacuum cleaner as it generates potentially damaging static electrical
charge.

To avoid future problems and compensate for malfunctions related
to self–demagnetization, contamination and physical shock damage,
you need to format the disk. No, not the Remake command in the
Sonic, but a “low level” format with a third party utility. A range of
products, such as La Cie’s Silverlining, Casablanca’s Drive7 and FWB’s
Hard Disk Toolkit (HDT), all will do the dirty deed. Be careful of the
more sophisticated products, such as HDT or CharisMac’s Anubis, since
they will change the firmware or permanent controller settings. This
causes problems later with Sonic. When in doubt, stick with the simple,
inexpensive Drive7.
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Start by shutting down the Mac, then power down the Sonic DMFS
disk. Unhook it from Sonic’s SCSI bus and reconnect it to the Mac
SCSI bus. Start up the Mac and then the SCSI software of choice. Once
it’s running, power up the Sonic disk and perform a low level format.
This will renew the magnetic “structure” of the disk and take any ques-
tionable areas on the disk out of service. With that accomplished, re-
connect the disk to the Sonic SCSI and Remake the disk as a DMFS
volume.

• Software configuration
Memory allocation
You need to reserve a block of RAM for the Sonic application. A

minimum of 16 MB is preassigned to the Sonic application. More
memory is needed for NoNOISE (at least 20 MB), Sonic Video (at
least 32 MB) and large EDLs with more that 200 edits (at least 24
MB). The Finder’s first Apple Menu entry is About This Macintosh…,
a window that can help you gauge the Sonic’s memory usage.

The Sonic folder
The Sonic folder can be installed anywhere on the HFS boot vol-

ume. Since you have to resize the Sonic application by Getting Info…
under the Finder’s File menu, why not make a mental note of the ver-
sion as well. It’s convenient to name the Sonic folder with the version
number contained within. Remember to make an alias for the Sonic
application as mentioned above.

Other folders
The Sonic system uses folders to organize the large number of files

that are created during a typical job. The SND folder keeps the DSP–
related Sonic files organized and must be on the root level of the Mac’s
HFS boot volume. The Sonic will create an SND folder for you in the
correct location, so don’t move it about. In fact, just ignore it.

A folders not automatically made for you is the JOBS or SHOWS
folder, the name depending on your work day. Create the folder at the
root level. If you make a folder for each new client, then the JOBS
folder will become an easy way to keep track of all your work, past and
present. I’ll talk more about this later in the Things to do section…

❢ ☞
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From an organizational standpoint, it’s counterproductive to save an
EDL, Project or Session into the SND or another random folder. If your
work (the files you make) is organized, you are likely to make fewer mis-
takes. Remember that the Macintosh can’t read your mind and “know”
where the file should go, though Mac tries it’s best. The General Controls
control panel has a “Last folder used in the application” setting that gets
you most of the way there. Another helpful suggestion is to drag the cur-
rent client’s folder onto the Desktop during the time you are working on
that job. Once done, a command-d in the Finder’s file Browser dialog will
always bring you to the Desktop where the client’s folder is parked.

Basic Signal Flow & Processing
• Audio I/O

3 audio signal paths
There are three separate and distinct signal paths in the Sonic; the load,

dump and monitor paths. The load path is equivalent to channel line in-
put. Usually, load is set to 1 & 2 in the Audio I/O preferences. This means
that inputs 1 & 2 on the D-I/O will become the line input to the Sonic for
stereo recording. The dump path, another stereo path, is equivalent to chan-
nel line output. Usually dump is set to 3 & 4, so outputs 3 & 4 on the D-
I/O becomes the line output from the Sonic.

Figure 2 - Mac
Folder Organiza-

tion
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The third path, monitor, is equivalent to the mix bus. Since the Sonic’s
mixing desk is the monitor path personified, its important to understand
the ins and outs of the monitor path. The M1 and M2 output assigns on
the mix desk are sent to outputs 1 & 2 on the D-I/O. As for input assigns
on the desk, L1 and L2 (input 1 & 2 on the D-I/O) are load or line input
and B3 and B4 (output 3 & 4 on the D-I/O) are dump or line out. Since
the mixing desk is for monitoring, the L and B input selections allow you
to listen to the line input or output without affecting the signal. So, AES
data comes into the Sonic, splits off so you can hear it on L1/2, and contin-
ues to the disk unaltered. In a similar fashion, audio is sent from the disk to
both the dump port and the B input on the desk for confidence monitor-
ing.

Remember that the three paths are separate. One of the great features of
the Sonic System is that different streams of audio can be routed to all three
paths simultaneously. You can load in some stereo source soundfiles while
you edit via the monitor path and still dump a finished product out to
DAT. See the figure below for a diagram of the Sonic’s I/O paths. The
“rotary switch” at the input to the monitor path is the input assign, men-
tioned above, at the top of each desk strip. The gadget connecting the
output of the monitor to the disk input is the capture (also called ping-
pong or bounce) function of the EDL. This is where playback from disk
through the monitor output is routed, then recorded, back to disk.

Channel Line Input - “Load”

Monitor - the “Desk”

Channel Line Output - “Dump”

Disk

EDL

L

B

A

L 1/2

M 1/2

B 3/4

• Recording
The load path
For a stereo recording, the load or input path goes directly to disk. Since

the load path has an AES input, the signal being brought in is not altered in
any way. There are user defined exceptions to this rule, though discussion

Figure 3 -
Simplified Signal Paths

❢ ☞
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of them is beyond the scope of this document. Remember that the L1/L2
input assigns on the desk are for monitoring only and will not affect a re-
cording unless you deliberately make it so.

To allocating or not to allocate
An allocated record allows a file to be played back and edited while the

recording progresses. Allocated records are defined by a nonzero duration
in the Project Manager or Record Soundfile dialog (the Project Manager
will be discussed later on…). Allocated records have a pre-roll. That is,
there is a countdown to zero at which time the recording starts. Wait until
the count hits zero before playing the source material. Allocated records
will automatically stop when the predefined duration is reached.

Unallocated records happen when you leave the duration at 00:00:00:00.
Unallocated records start immediately, with no pre-roll, and the Sonic be-
haves like a tape machine. The recording goes until you stop it or the Sonic
runs out of space on the disk. The Sonic cannot jump to another disk when
space is exhausted. If it runs out of space, that whole recording is unusable.

Time stamping
On occasion, you may want to apply a time stamp or starting address to

a new soundfile. This time stamp will cause the soundfile to open onto the
EDL’s timeline at that specific location. You may choose a source for the
time stamp address (9 pin, LTC reader or Active EDL) in the Record Sound-
file dialog. Usually however, time stamps are handled automatically, so
manual setup is rarely necessary.

Varispeed/SRC
Varispeed/sample rate conversion (SRC) is available on input or output

but not both. In the digital domain, varispeed is the same process as sample
rate conversion. The only difference is which sample rate, pre or post con-
version, is used for playback.

As an example, let’s assume that you take a 48 kHz file and SRC it to
yield a new, 44.1 kHz soundfile. Playback of this new file at the “old” 48
kHz rate produces a “varispeed” effect. The pitch is raised and the duration
is shortened. Playback at the correct, 44.1 kHz rate lets the new audio
sounds just like the original soundfile but your playing it at the “new” rate.
Clocking is critical, so be sure to pay attention to the prompts that remind
you to “switch the clock source” before and after the conversion.

❢ ☞
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The file path
Not so obvious is that the SND folder should be included in all file

paths. Whenever you use a function in the DSP or NoNOISE menu, Sonic
writes small parameter files to the Mac’s disk. Since the SND folder is
always present at the root level of the HFS disk, then tell Sonic to put those
little file in there instead of sprinkling them all over your disk!

Things to do before you start a job
So, are you ready to rock? Wait…not yet. Here’s a list of things that

need to be done prior to starting a new undertaking.

1) Create a new folder on the Mac Desktop and name it with the
client, record label, show or producer’s name. This folder will con-
tain all files for that job.

Figure 4 -
Sensible Path

Settings

❢ ☞
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2) Set the Record Path Pref.s and be sure to start the path with “SND:”

3) If you have more than one DMFS disk, choose a disk for this project
in Record Channel Preferences. This ensures all soundfile go to the
same destination. Enable as many channels as needed

4) In Audio I/O Pref.s, set the clock master and, for USP boxes, set
the input spigot.

5) Set the Cue Path Pref.s to into either the folder on the Desktop
that you just made or the Trash (folder), if you don’t use cues.

6) Open an EDL template or new EDL and save as or save that docu-
ment into that same new folder on the Desktop.

7) Chances are, you’ll be archiving, loading or dumping sometime
during this job, so make a new Project. Set the Customer as SND
and fill in the other two fields appropriately. Save the project into
that same new folder on the Desktop as well.

The names of the HFS folder, EDL, project, record and project paths
should all match each other. This ensures that all parts of a job or show are
consistently labeled and stored together in one place.

• The mixing desk
Patching
Remember, the USP’s scalable (resizable) mixing desk is the monitor

path. Selecting inputs to the monitor path is as simple as choosing an selec-
tion from the input assigns near the top of the desk. The first of four choices
is the load path or line inputs. Next is playback from disk or “auditions.”

Next are two lesser used choices, Bx and Cx. The B selection provides
confidence monitoring of the dump port. Since a stereo dump is usually
assigned to 3 & 4, B3 and B4 are used to check but not alter the dump
process. The last choice, C, is the cascaded output from adjacent desk strips.
By using specific input and output patching, adjacent pairs of strips can be
used as stereo super-strips replete with double the amount of EQ.

Output selection is simple. Since monitoring is usually in stereo, M1
and M2 are the usual mix assigns. The X selection disabled or turns off that
strip’s output. If you hold down the command key while setting the output
bus assigns, the Sonic automatically sets all strips to M1/M2. If you hold
down both command and control keys, the Sonic automatically sets all
strips sequentially.
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Faders
The desk’s faders are very simple, just click-hold and drag. Clicking on

the dark center “track” causes a fader to snap to that setting. The aqua
colored “hot spots” along the sides of fader travel cause the fader to snap or
jump to +24, 0 and -∞ settings. Holding down the control key while drag-
ging yields finer adjustment and the option key provides grouping.

The master faders have a hidden talent. If you drag and drop an AIFF
file from a DMFS or HFS volume or from the Sonic Manager onto the
master faders, Sonic queues up the files and plays them in turn. Very handy
for previewing a soundfile or cue prior to use.

EQ
There are two version of EQ; the basic EQ that comes with any Sonic

and optional extended EQ. Let’s take a detailed look at the more com-
monly used parameters. Gain is pretty obvious but how about Q? Q is a
way of describing the bandwidth, or range of frequencies, that the filter
will affect at full boost or cut. We use Q rather than bandwidth because Q
takes into account the way that our hearing works. We hear better at low
frequencies so a filter needs to have a wider bandwidth the higher you set
the   filter frequency. Q does that automatically, making a filter sound the
same at any frequency.

 The order of a filter is the slope of the filter’s frequency response when
plotted as gain versus frequency. In other words, how wide a range of fre-
quencies does the filter “need” to get to full boost or cut. A 1st order filter
has a very gentle 6 dB per octave slope. It would affect almost the entire
audio band. A 4th order filter has a 24 dB (6 times 4) slope. It’s action can
be precisely defined within a narrow range of frequencies. The order and
the Q of a filter interact. If, for instance, you keep the Q constant and
change the order, a quite different range of frequencies will be changed.
Unfortunately, you don’t get somethin’ for nothin’. As the order or Q are
increased, the phase response of the filter degrades. This makes the filter
more likely to ring or resonate and sound harsh.

A dynamics processor is also optionally included. The dynamics are de-
signed to subtly alter the dynamic range, not to perform more heavy handed
tasks such as peak limiting. The dynamics work only below threshold and
will compress or expand the quieter material. Compressing will make the
quiet passages, along with the noise floor, louder. This will allow you to
subtly reduce the dynamic range of material. Expanding will further quiet
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down the audio already below threshold. This can subjectively help a re-
cording with a high noise floor.

• SCSI transactions
Disk channels
It’s very important to understand the data transfer limitations of the Sonic

System. Only a  finite amount of data can be written to and read from the
SCSI bus at once. A 12 MB USP limits that amount to 30 “disk channels”
or monaural audio streams at 16 bits. A 48 MB USP is capable of 30 disk
channels at 24 bits. If you “tell” the Sonic to play more than the maximum
number, then some disk channels will drop out or not be played.

When recording a 16 bit stereo pair, 3 disk channels are used. Two are
for the audio data and one is for the “reduce files” or waveform display
data. That extra bandwidth for the reduce file is needed only during record.
When playing back a stereo pair containing crossfade edits, 4 disk channels
are used during the crossfade. So, 7 edited stereo pairs (7 x 2 channels in
stereo x 2 during the crossfade = 28 which is less than 30) are guaranteed to
reliably play back on a USP without dropouts. Of course, if an edit and it’s
accompanying crossfade doesn’t happen across all 7 stereo pairs at the same
location, then you can play more tracks than that without dropouts.

Desk overlays
The name “desk overlay” comes from the idea of mixing or overlaying sev-

eral sounds on top of each other at the input to a desk strip. Like the SCSI bus
mentioned above, those strip inputs are also bandwidth limited. Whereas an ana-
log mixing desk has a summing node at the input to an amplifier, the Sonic’s
digital desk is manipulating streams of data. The analog circuit is limited by the
electrical characteristics of the circuitry, such as current draw and voltage swing,
and the Sonic is limited as well. It can route only a finite number of data
interconnections at any instant.

To be more specific, you can assign as many tracks from the EDL as you
want, using the panel’s EDL Audition popup, but in 4 strip mode only the first
4 disk channels that are played to that strip’s input will be heard. In 8 or 16 strip
mode, only the first 2 disk channels will be heard. Additional disk channels
arriving afterwards will not be played. The only way to force or predict which
disk channels “win the race” is to play only the maximum number and no
more. As discussed below in the section entitled “Getting around in the EDL,”
it’s easy to play only selected panels/tracks in an EDL.

❢ ☞

❢ ☞
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Basic Editing
• Components of the EDL

Panels and tracks
An EDL, or edit decision list, is an ASCII text file that details the play-

back of soundfiles from the Sonic’s disk. Panels, those repeated rectangular
constructs in an EDL, can be thought of as windows for viewing and ma-
nipulating tracks. Tracks, on the other hand, are containers for soundfiles
stored on the Sonic sound drive. Many tracks can be “filled” with sound
and available for editing but only those visible in a panel can be worked on.
If a track isn’t open in a panel, it’s hidden from being played or edited.
Tracks can be swapped in and out of panels at any time. So, tracks not
being worked on can be “put away” for later review or use. Together, panels
and tracks make a simple and versatile editing framework.

Display modes
There are four ways to display sound in a panel. The most common

display mode is an amplitude versus time or waveform display. By default,
the amplitude is autoscaling to always show the maximum detail.

Bars mode is a simple timeline view. Bars, like text mode discussed later,
have the advantage of always displaying the name of the sound and hiding
the waveform shape. That simplicity speeds track redraws, especially lengthy
or complex ones. Both bars and waveforms can be magnified to show any
desired time interval.

Also quite useful is the text mode which can simultaneously show six
important values. More on this later in the “Text manipulation” section.

Gates
Double clicking anywhere in the waveform display makes the left and

right Gate visible. The Gates provide a visual way to indicate or delimit a
piece of audio.

Sometimes you want “tell” the Sonic to work on all of the audio that’s
visible. To do this, you have to get rid of the Gates. To throw away the
Gates, click-hold the right Gate and drag it all the way to the left of the
waveform display. Both Gates will disappear. They are invisibly “parked” at
the extreme ends of the currently visible timeline.
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Essential controls
The sync group popup lets the Sonic operate on multichannel audio

without worrying about individual channels. When an EDL is correctly
configured, multichannel audio is automatically played, viewed and edited
as a group. At any time, you can override the sync group assign by holding
down the control key. If you are using the Sonic properly, you should never
have to change the sync group once an EDL is initially configured. Under-
standing the function of the sync and edit groups, discussed below, are very
important to the quick and painless use of the Sonic System.

The track number popup shown below provides a way to select which
track is visible in a panel at any one time. As mentioned above, tracks can
be swapped in and out of panels at any time. Simply click-hold on the
track number popup and drag to select a particular track in the list.

The number of tracks in an EDL is determined largely by how many
soundfiles have been opened into that EDL. As a new soundfile is opened,
new tracks (one for each channel) are created to contain it. Opening a
stereo soundfile would create two new tracks. The number of new, empty
tracks that appear when the last ones are filled is controlled by the Edit/
Sync setting in the EDL Preferences.

Figure 5 -
Track Number

Popup
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Edit groups are the determining factor in deciding what audio is used
when an edit is performed. The basic editing model in the Sonic dictates
that a copy of some part or all of the audio in the source track(s) is placed in
the destination track. The edit group determines source or destination.
Always remain aware of which tracks are source and which are destination.

The way that you route a track to the monitor path for playback is
through the EDL’s audition assign. This assign, when matched to a desk
strip input assign, will let the track play out of the monitor bus. See the “3
signal paths” and “The mixing desk” sections above for a review of moni-
toring.

• Getting around in the EDL
Opening a Soundfile
The fastest and most fail-safe way to open a soundfile is to use the

Sonic Manager. By default, EDLs are set so that soundfiles open into
source tracks. That is, tracks whose edit group are set to source. Select
the File>Managers>Sonic Manager… to open, then click on the Sounds
button. Find the soundfile of interest and point and click to select it.
Then, double click on it. It will appear in the source tracks, ready to
play and edit. Once opened, you can select the next empty track, make
it a source (hitting the s key) and open another soundfile. In a typical 4
panel EDL and stereo soundfiles, you would open the first sound into
tracks 3 and 4  in panels 3 and 4. Then you would switch, in panel 3,
from track 3 to track 5. Track 6 will follow into panel 4 automatically.
Now your ready to hit the s key, open a soundfile and repeat the process
until all of the raw soundfiles are in the EDL.

Playing
The most common way to play audio is to place the left Gate where you

want playing to start and tap the space bar. The Sonic’s Play menu has
many other commands for playing audio in an EDL. Take a look and ex-

Figure 6 - Edit/
Sync EDL
Preference
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periment. The aforementioned Sonic Manager will also audition or pre-
view-play a selected soundfile.

Usually the Sonic will play at 1x play speed but variable speed scrubbing
or jogging is also possible. Jogging and shuttling allow you to listen to
material in a track at less than normal play speed. With a soundfile open
into the selected track, hitting the r key will start jog/shuttle mode. Shuttle
mode provides a constant speed play ranging from -0.5 to 1. Point to the
center of the waveform display and click-hold down the mouse button.
Moving the cursor to the right of center will increase the forward play
speed and moving to the left will increase reverse play speed.

Jogging is set by clicking on the small encircled S at the lower left side of
the EDL. The S switches to a J to indicate jog mode. Jogging emulates the
act of grabbing the tape flanges of an open reel deck and scrubbing the tape
over the heads. Clicking on the J will switch back to shuttle mode.

Zooming & moving
As with the Play menu, the View menu has many commands for chang-

ing magnification and moving the view of the track about in the panel.
Experiment with the various commands. The single most often used com-
mand, Zoom To Entire Track, is available by hitting the e key alone. As
mentioned above, the panel’s amplitude is usually set for autoscaling to
always show the maximum detail.

• Finally, editing
What’s a track again?
To review, tracks are containers for soundfiles stored on the Sonic sound

drive. Many tracks can be “filled” with sound and are available for editing
but only those visible in a panel can be worked on. If a track isn’t visible in
a panel, it’s hidden from being played or edited. Tracks can be swapped in
and out of panels at any time. So, tracks not being worked on can be “put
away” for later review or use.

Edit point editing
Arguably, the fastest and most common way to do linear assemble edit-

ing is to use edit points. The idea is to define some material in one or more
source tracks and edit a copy into the destination tracks. You can either
insert material into the destination or delete existing material from the
destination.
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To do this, place In and Out edit points in the source tracks using the
Mark menu. You can place one In or Out or both in either the source or
destination tracks or both. So, one to four edit points are placed and the
edit is performed. An EDL is usually built by adding sound to the destina-
tion tracks, starting at the earliest sound in the timeline and move “down-
stream,” later in time.

Edit points are placed with the left and right Gate. Double-click in the
waveform display to make both Gates appear. The left Gate places In edit
points and the right Gate places Out edit points. The [ key will place the In
edit point and the ] key will place the Out. Edit points in the source specify
the start (In) and/or end (Out) of the source material. Edit points in the
destination specify where the copy of the source is placed. If an edit point
is omitted, the Sonic assumes you want to use the rest of the track. Take an
example of an Out edit point halfway through a whole track. If you zoom
to the entire track (hit the e key), you will notice the pink vertical bars
marking the head and tail of the soundfile. So, with only an Out point in
the track, the Sonic will use all the audio from the beginning of the sound-
file up to the Out edit point. A lone In edit point would do the opposite,
defining the part from the In edit to the end of the soundfile as the source.
By the way, the vertical pink bars are black fades and are discussed in the
segment editing section below.

Edit points in the destination define where the source material is placed.
An In edit point in the destination will force the head of the source mate-
rial to be placed at that location on the timeline. A lone Out point will
force the tail of the source material to be placed at that time. The sound
will be “back–timed,” filling the time line up to the Out point. To indicate
whether an unseen edit point is somewhere in the track, a small encircled I
and/or O appear at the lower left side of the EDL.

How about deleting audio? The same rules apply. An In and Out in the
middle of a sound will leave a hole when you Edit>Delete>Del. w/BLACK-
FADE. But what if you don’t want a hole? You may want the Sonic to stitch
up the hole and leave behind a seamless crossfade. That’s what ripple edits
are all about. Ripple edits will compensate for any discrepancy in duration.
Delete and Ripple closes up the digital black let by the deletion and Insert
and Ripple move the audio downstream from an In point to “make room”
for the source material.

Remember, the Sonic will never make a creative decision for you. It
simply performs the edit as best it can given the edit points you’ve placed.
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Experiment with some familiar material so as to acquaint yourself with edit
point editing.

Crossfades
When ever you insert or delete material in the destination, the Sonic

leaves behind a fade. A fade is a envelope or amplitude ramp to provide a
seamless transition. Sometimes its a black fade, that is, a transition to or
from digital black. Other times it will be a crossfade providing a smooth
change from one piece of audio to another. The Sonic lets you choose
which fade type is most appropriate for any edit.

Loop & fill
There is special form of a four point edit that allows you to define a

source sound with In and Out points and a longer duration destination
also with both edit points. The Edit>Loop and Fill command will create as
many copies of the source as necessary to fill the destination. This com-
mand is active only when the destination panel is selected. If you want, you
can use a selected segment in the source track instead of edit points.

Advanced Editing
• The tool bar

Introduction
The tool bar is that busy area along the top of any EDL. It contains four

tool buttons at left, five timetext or time display fields and one rectangular
button just to the left of the center window. The tool buttons change the
appearance and behavior of the cursor. To speed your work, the four tools
can be accessed from the keyboard. The g (Gates), f (fade), r (rock n’ roll)
and t (take or segment) keys provide the same function as clicking on the
tool buttons.

Gates
The left–most tool button activates the Gates tool. In this mode the

cursor controls the Gates. The cursor retains its standard arrow shape.

Rock ‘n Roll
Slightly more challenging is the Rock ’n Roll tool. Notice the cursor’s

change in shape. This is the same jog/shuttle mode discussed earlier.
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Fade
The Fade tool lets you change the duration and location of a fade with-

out leaving the EDL. To use this tool, start in Gates mode and zoom in on
the fade of interest. Then click on the Fade tool and again the cursor changes
shape.

Point and click in the very middle of a black or crossfade. Little boxes or
handles appear at the outer edge of the fade. Click-hold and drag the upper
handle a small amount then let go. The fade should have changed dura-
tion. If you hold down the control key before dragging a handle, you can
jog audition or “hear the edge” of the fade envelope as you modify the
duration.

By click–holding on the center to select a fade and dragging, you can
move the whole fade to a new location without changing duration. This
action will hide or reveal underlying audio as the edit event is moved.

Segment
To move a segment, use the Segment tool. Editing with segments is

discussed in the next section.

• Segment editing
Creating segments
Occasionally, you need to move two or more pieces of audio at once.

Or, you need to do sloppy editing and aren’t too concerned with the finer
points. In that case, segment editing is for you!

The Sonic thinks of any piece of audio in a track that has a black fade
(those pink things) at the head and tail as a segment. If you examine a
soundfile after opening it into a track, you will see the black fades marking
the head and tail of the soundfile. When you zoom way in on one by
placing the Gates on either side and selecting View>Zoom To Gates, you
will see the characteristic triangular pink fade symbol.

So, what about segment editing? First, chop a soundfile into two seg-
ments by placing an In point in a sound and go for the Edit>Create New
Crossfade command. This will place an inaudible cross fade in the sound,
making two segments from one. To separate a particular piece of sound
from its surroundings, move the left and right Gates to the beginning and
end of the audio of interest. Use the Edit>Create Segments>From Gates
command. Notice that the audio, now a separate segment, has filled in



33

with color. This shows that the segment is selected. The Sonic treats that
segment as if it had an In and Out point in place of the delineating cross-
fades.

The other three variations in the Edit>Create Segments submenu rely
on the placement of segment marks. You can manually place start and end
of segment marks by using the Mark submenu under the mark menu. The
left Gate will place start of segment marks while the right Gate will place
end of segment marks.

If you have a track with well defined signal in a quiet noise floor, you
can use the Mark>Analog Black To Marks… command to create segments
based on amplitude. Zoom to Entire, throw the Gates away (click-hold the
right Gate and drag it all the way to the left) and fire off the command. In
the resulting dialog, you can specify the amplitude of the noise, a mini-
mum duration for the new segments and that you want segment marks.
The default numbers work fine for starters, just select segment marks. Think
of this function as a strange kind of noise gate. The command places seg-
ment mark ready for the Edit>Create Segments submenu. The resulting
segments will be alternating loud and quiet passages. All of the loud seg-
ments are automatically selected.

Once a segment has been created from the parent soundfile, you can
give it a name. The EDL’s text display mode makes this possible. Start with
the EDL>Display Panel As…>Text command, then double click in the
name column. The resulting dialog allows you to change it from the de-
fault name to whatever you like. In EDL>Display Panel As…>Bars mode,
you can see each segment’s name easily while retaining the timeline view.

Selecting various items
You may need to select multiple segments or panels in an EDL or items

in the Sonic Manager. To select a segment, hold down the option key,
point and click with the Gates tool. There are two keys that work in con-
junction with this. By also holding down the Apple or command key, you
get an exclusive selection. That is, you select only that on which you spe-
cifically click. The shift key allows an inclusive selection. You select every-
thing between two clicks. The shift and command key behavior is com-
mon throughout the Sonic, so try these two modifier keys in the EDL or
Sonic Manager for yourself.

The Edit>Select Segment submenu provides several commands for in-
verting current selections, selecting between the gates, etc. Selected seg-
ments can be also be locked, preventing any change whatsoever. Locked
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segments are orange colored when selected. When editing, if there are both
selected segments and edit points in a track, the edit points will be ignored.
Be careful!

Moving
You can, of course, use the commands under the Edit menu to move a

copy of a selected source segment to the destination. There are, however,
more visceral ways to get that segment into the destination.

The Segment tool allows dragging of segments on the timeline or from
one track to another. In segment mode, simply click-hold on a segment
then drag it to a different location. You can also drag a segment to a com-
pletely different track. It helps to set the source and destination tracks to a
similar zoom ratio to ensure proper placement. Note that when you drag a
segment, you remove from it’s current position and move it to the new
location.

There are two modifier keys for segment dragging. The shift key con-
strains the movement, preventing any shift on the timeline. The option
key clones the segment, dragging a copy rather than the original.

Gain adjustment
The Edit>Adjust Gain dialog works on selected segments. If no seg-

ments are selected, it works on the entire track if the Gates have been thrown
away. If the left Gate is inside a segment, then that segment will be gain
adjusted. So, get in the habit of throwing away the Gates or explicitly se-
lecting segments before using this command. Gain adjusting has two modes;
absolute and relative. Absolute means just that; set the gain, ignoring the
previous state. Relative adds or subtracts from the current gain setting. You
can also invert the polarity of segments or the whole track. The normalize
function will increase the gain as much as necessary without clipping or
going above 0 dBfs.

Flushing frivolous fades
What with all the creation of segments going on in the previous section,

you may end up a few extra segments in a track. The Edit>Delete Cross-
fade command will remove any crossfades within the Gates that are inau-
dible. Any fade “doing real work” will not be retired. Long ago in simpler
times, this function was called “Flush Frivolous Fades,” which was an apt
description.
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Cues
After having defined and named one or more segments, you can select

them and save them as cues. Cues
are “pointers,” not actual audio and
aren’t dependent on the EDL in
which they were originally defined.
They are portable in that they can
be used in any EDL as long as the
parent soundfile remains on disk.
Think of them as predefined pieces
of audio, ready to use, over and over
again.

The Sonic Manager has a list of
all existing cues and the Cue Place-
ment palette, under the EDL menu,
has four ways for you to drag and
drop them into your EDL.

• Text manipulation
Moving sound around
Selected segments can be moved

in time by double clicking on the
start or end time of any segment.
The resulting timetext dialog shows
the current location on the timeline
and can be modified to move the
segment to the new location. All
other selected segments will move
by an equal amount. That is, all se-
lected segments move together.

You can also move selected seg-
ments directly to another track. This
is equivalent to shift-dragging segments across tracks. Simply double click
on the track number of one or more selected segments and change the
track number.

Figure 7 -
Record Desk

Setup
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With multichannel audio, remember to always choose an odd or even
track number to match the current track’s number. For example; a stereo
pair of segments are on tracks 11 and 12 and the left channel/panel is a
waveform display and the right channel/panel is text. You would double
click on the right channels track number and the resulting dialog shows the
current track number, 12. You should move that segment to another even
track number, 14, 16, 22 or another even number and the selected seg-
ment in the left channel will “follow” to the adjacent, lower numbered odd
track. So, if you move it to 14 the left channel will go to 13.

Viewing Modes
The text view has three ways to show time relationships of segments.

Pointing to the start column’s title, “start seg,” and clicking will switch to
“start edit.” Another click will switch to “start snd” and one more click will
switch back to “start seg” again. The three modes are segment, edit and
sound.

Segment mode displays the start, end and duration of a segment based
on the first and last sample. Edit mode uses the head and tail edit events
inside the fade envelopes as the reference. Sound mode shows the “source
reel” times, the location of the first and last sample’s location in the parent
soundfile. Sound mode also shows the full name of the segment.

Gain again
Double clicking on the Gain column brings up the same Adjust Gain

dialog discussed earlier. As with the earlier discussion, multiple selected
segments will be acted on together.

• Free form editing
Cut/Copy & Paste
As mentioned above, edit groups are the determining factor in deciding

what audio is used when an edit is performed. The basic editing model in
the Sonic dictates that a copy of the defined audio in the source track(s) is
placed in the destination track. Well, there is a way around this rule and
that way is cut/copy/paste.

Cut/copy and paste “looks” for selected panels and segments, not edit
group settings. Cut or copy first checks if the selected panel is set to source
or destination. Then it scans for selected segments. If selected segments are
present, it will act on those segments. It will also act on all selected seg-
ments in other tracks with the same edit group. If the selected panel’s edit
group is set to none, then it will act only on selected segments in the se-
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lected panels. Be aware of which segments are selected and which edit groups
are set in the selected panels. Cut/copy and paste is possible between any
track, even the same one or in another EDL.

• QuicKeys
Just learn it!
Fast and efficient operation of the Sonic requires the use of QuicKeys.

Every function or command in the Sonic’s menus can be assign a QuicKey
and is usually already in our Sonic keyset. It is beyond the scope of this
document to teach even the basics of QuicKey administration and use. CE
Software’s documentation is sufficient to get the novice working quickly
with our keyset. Simply copy or move the Sonic keyset file, not folder, into
the System Folder:Preferences:QuicKeys Folder:Keysets folder, restart the
Mac and off you go. More in depth use, such as writing new sequences,
requires some reading on your part and maybe a call or two the manufac-
turer for technical support.

• The EDL & recording
“Captures,” bouncing or recording into the EDL
To perform a capture, you must set up the process. First, the

File>Preferences>Record Path… preferences are chosen to give the new
soundfiles a sensible name. Also, turn on the Auto Increment function.
Both the channel and naming preferences can be set ahead of time and left
as they are for an extended period.

The mixing desk has two states, either playback or record. This allows
the Sonic to emulate a tape recorder in repro (playback) or selsync/simulsync
(record) mode. Try using the record setup shown in the figure below. This
allows you or the talent to hear the playback at reduced level “under” the
channel line input. Set up the desk as shown, then use the Desk>Save Record
Setup command. Check the playback setting by selecting Desk>Use Play-
back Desk and correct the setup if desired. Make sure your output assigns
are correct and select Desk>Save Playback Desk if you make any changes.
Control–r (remember “repro”) switches to Playback Desk and control–i
(remember “input”) switches to Record Desk to hear your input before
recording.

Now set up the EDL for direct recording. Start by deciding into which
panels you will record. They can have soundfiles in them but empty tracks
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are a good place to start. Then, use the Input Selector popup to choose
which line input you want as the source. L3/4 are typically used. The z and
x keys toggle between safe and ready record modes. As mentioned above,
the mixing desk will switch from the playback setup to the record setup as
you punch into record.

To start recording, hit the x key to go into record ready. Begin playing
the selected panels using the space bar, then hit the / key to go into record.
Hit the / key again to come out of record. If you want to bail out and abort
the record, hit the delete key instead.

EQ during record
Using this same setup, you can pass the line input through the desk to

do an EQ’d load. Modifying the audio on the way to the disk is achieved by
simply setting up the desk as desired and selecting M (monitor) rather than
L (line) in the EDL’s Input Selector popup. Setup suggestions are shown
below. If your doing an EQ’d load, Set the EDL’s audition assign to OFF so
the desk doesn’t switch to Record Desk mode.

Notice how, in the bottom two panels, the audition assign is set to A3/
4. Also notice that, on the desk, the second two strips have switched to the
Record Desk mode automatically so as to hear the line input 3 and 4. This
happened because the Playback Desk has strips 3 and 4 set to A3/4. When
the EDL is punched in on a track whose audition assign matches a corre-
sponding input assign on the desk, the Sonic “switches” from Playback
Desk mode to Record Desk for those strips with matching input assigns.
A3/4 on strip 3 and 4 switches to L3/4 because the Record Desk is set that
way as in figure 7.

Figure 8 - EDL
Record
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The illustration above shows all four panels/tracks in play mode (option
spacebar) and edit points in the source. A tap of the / key has placed those
source tracks in record ready. Notice the red R to the left of the input assign
L3/4. When the play pointer hits the edit points, the Sonic will autopunch
into, then out of record. In the case of an EQ’d load, the only difference is
that you wouldn’t be playing those tracks (1 & 2)

In the above case, we’re playing out tracks 1 and 2 through the desk,
into the input assigns back into the EDL, then out to disk as a new sound-
file! This is compositing where you’re mixing multiple sources through the
desk back to disk. This is useful when your EDL gets so complicated that
you run out of disk bandwidth, causing sounds to drop out of the audition.
This approach leaves the new “captured” soundfile in a separate track. You
can also bounce into the same track as your “dry” audio by placing edit
points in the track & assigning as in the bottom panels of figure 9.

Figure 10 -
Compositing

Figure 9 - EDL
Overdub or EQ’d

Record
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More Advanced Editing
• Editing a fade

What is a default fade?
Default fades are the predefined fades that are used for all editing in the

Sonic. After you have made an edit, you can modify or “edit ” the fades
that make up the edit. But, initially, the fade will use the preset parameters
from the File>Preferences>Edit Fade… dialog.

The Edit Fade dialog is the basis for power editing in the Sonic. Diffi-
cult as it seems at first, it simply requires a bit of practice and some familiar
material for listening. Load in a song that you know very well and open it
into a new EDL. Change the track containing the song into a destination
(hit the d key), place edit points at the beginning and end of a verse and
delete and ripple that verse with a crossfade. To check the placement of the
edit points before taking the edit, use the four rehearsal commands mapped
to the F5 through 8 keys.

After you’ve made the edit, it has the default or preset parameters which
means it may not sound perfect. Move the Gates such that there’s only one
cross or black fade between the Gates and then select the Edit>Edit Fade…
command. The resulting dialog offers adjustments for every parameter, al-
lowing you to perform “impossible” edits.

What you’re seeing is the outgoing segment in the top panel and the
incoming on the bottom, not the left and right channels as in the EDL.
Edit the fade and muck about in the dialog until it starts to make sense.
Remember to always check the state of the Fade-In, Fade-Out and Lock
Sound checkboxes as soon as you open the dialog. Turn Fade-In & Fade-
Out on and Lock Sound off before proceeding to change anything.

Auditioning
The most obvious function takes the form of the Audition button. As-

suming it’s a crossfade that your editing, this will let you hear either the
component black fades by themselves or the whole crossfade. Which fade
plays depends on two things; whether both black fades are being modified
as defined by the check boxes at the far left center of the dialog and if the
Audition Both checkbox is checked. More on this below.
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Envelope Types
Back to which black fade is being modified; In the left center of the

dialog are two rows containing duplicate controls for each black fade that
together make a crossfade. A popup is provided to define the basic shape,
the gain versus time law, of each black fade. Try each selection in the popup
to see the difference between the different shapes. Remember that the check
box at the far left of each row allows or prevents you from modifying that
fade. The upper row of controls is for the outgoing or fade to black. The
lower row is for the incoming or fade from black.

Duration
The duration slider adjusts, you guessed it, the total duration of the

fades. Try increasing the duration to 5 seconds and listen to the result. Now
change the envelope type and listen again. The duration can go from slightly
less than 3 milliseconds (ms) to 100 seconds.

Overlap
The overlap slider determines whether or not both black fades occupy

the same place on the timeline. Zoom in if you like (the down arrow key)
to see better, then listen to various settings. Keep the duration long (>4
sec.) to allow you to hear and see the effect of any change.

dB down
The dB Down slider sets the amount of gain in the center of a sym-

metrical 50% overlap fade. If the crossfade is set to something other than
50%/50%, then this control will not be calibrated. Notice that it changes
the shape of the fades. A rule of thumb is that when crossfading across
similar material, use a 6 dB down setting. When crossfading between dis-
similar material, such as a segue from one song to another, use a 3 dB down
setting.

Figure 11 -
Selecting Black
Fades in Edit

Fade…
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Don’t bother with the Power Lock checkbox, leave it on. This automatic
control attempts to set the dB Down parameter correctly for each envelope
type.

Alpha
The Alpha slider is an additional shape control only for the Alpha-Ex-

ponential envelope type.

Lock Sound
The Lock Sound checkbox will prevent any change in the Edit Fade

dialog from moving audio on the timeline. For mix to pix jobs, this control
is essential to prevent “downstream” loss of sync with the picture. For now,
just make sure it’s off.

Edit point nudge
Just like in the EDL, you can move edit points to a new location by

moving the Gates and hitting the [ key for the In edit point and the ] key
for the Out. Very rarely would you want to move either edit point with
sound locked in place so pay attention to the Lock Sound checkbox. There
are also provisions for moving fades by a predefined amount. At the lower
left of the dialog is a set of horizontal arrow shaped buttons and three radio
button to set the amount the edit will move. Experiment to get a feeling for
these controls. Remember that any mistakes you make are easily remedied.
Just click on the Cancel button and try again. By clicking on the Revert
button, you can even undo without leaving the Edit Fade dialog.

• The Project Manager
Project file vs the Project Manager
The Sonic has a built-in tape operator and librarian in the form of the

Project Manager (PM). The PM saves all of it’s settings in a project file
which is stored, like EDLs and Sessions, on the Mac disk. Projects can
contain all of the information needed to load or record source material into
the Sonic, deliver (dump) finished EDLs to tape or CD and archive com-
pleted jobs for posterity.

When to use the PM
The PM is useful but, like any tool, it is most productive when you have

an understanding of the situations in which it functions best. The PM
works most efficiently with timed transports (9 pin with time code) but
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even “wild” or manually controlled sources benefit from a little manage-
ment. The Source log serves to bring in source soundfiles from a Load
machine which, in many studios, is not a timed transport. Using the PM is
still more efficient, in may instances, than using the Transport Panel. If the
source soundfiles are longer than a few minutes or several are coming from
the same tape, the PM is the method of choice.

There are two uses of the Sonic which absolutely require use of the PM.
These are archiving material from the Sonic to digital audio or Exabyte
tape, or dumping material from the Sonic to the CD Printer. Archiving
means saving all essential info on a job prior to removing it from the Sonic.
Outside of these applications, use of the PM is optional, but there are some
operations that it streamlines. Two examples follow…

Stringing together multiple EDLs
When assembling a composite track, each individual cut or section may

be prepared as a separate EDL. The PM can be used to control the order
and timing in which the cuts are transferred to a mastering medium. An-
other case might be where DME elements of a film have been edited with
a separate EDL for each reel, which must then be played back in succession
to create an entire soundtrack.

Using the machine control option to extract bits and pieces from mul-
tiple reels of logged material — Audio editing often consists of locating
and transferring good takes from many time coded reels of raw material
and then editing them into a final form. If the source device is placed
under 9 pin control, a list of the desired portions of the material can be
entered in the Source Log and the PM instructed to load it. The job of
locating and transferring each cut is then performed by the system.

The following discussion may try your patience but do persevere. Though
the PM may seem an unnecessarily rigid approach, the benefits far out-
weigh the initial inconvenience. So, please endure the following dry, mini-
malist discussion of the PM and it’s myriad charms…

Folder hierarchy
When a new project is created, the Sonic makes a tri-level folder hierar-

chy that organizes, labels and contains the source soundfiles. This rigid
hierarchy may seem troublesome but, by filling in those fields, you auto-
matically “clean up your act!,” making disorganization less likely. We even
provide a work order number (WO) field.
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Source, Delivery, and Archive Logs
In the Sonic, a log is a list of audio materials accompanied by appropri-

ate timing information. Logs are used to control automated loading and
dumping of materials, and provides a printable text record of materials
used in a project. There are three types of logs used by the system.

The Source Log
Soundfiles on a manually controlled wild tape can be unallocated or

allocated, depending on how you define them. If a tape is wild, always
leave the soundfile’s absolute start time at zero. The end times, if also left at
zero, will produce an unallocated record. If you enter a relative end time
(ends after beginning) rather than an absolute time, the load or recording
will be allocated. Remember that allocated records have a pre-roll. Another
Source log hint; The sole reason for defining cuts within a soundfile is for
later use in labeling the start of track marks in the EDL’s Mark Info dialog.

The Source Log is a list of material to be loaded into the system for a
particular job. These are divided into Tapes. Each Tape carries one or more
soundfiles to be used in the finished product. Each soundfile is identified
by a Start and End time.

The Delivery Log
After recording, the source materials of a project are assembled into one

or more EDLs. When the process is complete, the operator typically dumps
the results onto a tape, CD or Exabyte. The Delivery Log is a list of EDLs
that make up a project, as delivered to the client. The start time of each list
is included, as an absolute time or relative to the end of the preceding
EDL. The completed log is then dumped with a single command. The
dump proceeds in the background, allowing the user to do other work at
the same time.

The Archive Log
The Archive includes all source materials, as well as the complete infor-

mation describing the editing work done before. At any time, the entire
project can be restored to disk, just as it was at the time the archive was
created. There are special consideration in creating and restoring archives,
which are described a bit later.

Creating a new project
The process of using the PM starts with the creation of a new project

file. Select File>New>New Project…. The Sonic prompts the user to enter
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a series of three names, used to create a series of nested folders in the Sonic’s
digital media file system (DMFS).

Type a label into each of the three fields in the dialog that will jog your
memory a year from now. Click on OK or hit the enter key. When the New
Project dialog closes, the project window appears. There are three buttons
along the bottom of the project window. Each button corresponds to one
of the three principle types of log used by the Project Manager.

Log mechanics
The three log types are similar in the way that they work, but there are

also important differences. To create the Source Log, click on the Source
button in the PM window. The Source Log window appears on screen.
The Source Log dialog consists of one large text window and a series of
buttons along the bottom. Using the buttons, you define one or more Tapes,
which correspond to individual source reels. A “tape” is really any storage
medium; video or audio tape, CD or even magnetic or optical film. So, a
“tape” is anything with audio on it that you want to get into the Sonic.

A log always contains at least one tape, and the first step in defining the
contents of the log is to create the first tape. Click once on the Add Tape
button. The system provides a default name but the idea here is to use a
name that will make sense six months from now. Look on the tape box or
the title of the tape itself. What does it say? Put that in the dialog. The
Timed Tape option can be used only if you have the Machine Control
option. Wild “tapes,” such as a consumer DAT or CD, are manually con-
trolled. Start Time and Duration are used by the machine control software
to determine if the current time code is in range. The start time is the
starting TC address on the source tape. Duration is the physical length of
the tape. Ignore both of these for wild tapes. After entering a tape name
and selecting timed or wild, close the dialog. The defined tape will appear
as a line of text in the top of the Source Log’s main window.

Entering soundfiles
Once the first tape is defined, you’re is ready to enter the names and

timings of the soundfiles to be load from that tape. The “Add Tape” button
can be changed into an “Add SoundFile” button by double-clicking on the
line or entry in the text window that lists the tape you just defined. The
“Add SoundFile” button is used to list sections of the tape that are to be
loaded or recorded as part of your project.
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Soundfiles are specified by a name, together with a start and end time.
Soundfiles can also be defined as either monaural, 2 or 4 channel. Click on
the Add SoundFile button. This opens the SoundFile Info dialog, which
includes fields to define the key parameters. The soundfile name should be
kept short but legible, don’t make it so short that it doesn’t make sense.
Don’t use colons or other non-letter/number characters such as slashes as-
terisks or dollar signs.

The Start Time is specified as an absolute TC address. For wild tapes,
leave it at zero. The end of the soundfile can be specified as an absolute TC
address (Absolute Time on This Tape), or as a relative duration (After Be-
ginning of SoundFile). In either case, the Sonic will use the result to deter-
mine the length of the file to be recorded and will stop recording after the
specified time.

When the SoundFile Info dialog is closed, the user is returned to the
Source Log window. The name of the soundfile is displayed, indented be-
neath the name of the Tape on which it is contained. The same procedure
is repeated until all soundfiles on the first tape have been entered. Repeat as
necessary.

It’s time to mention a particular user interface behavior of the three logs.
If you double-click on the line in the Source Log text window that lists the
name of a tape, it shows the contents, soundfiles, on the tape. After “open-
ing” the tape in this way, the Add SoundFile button can be used to make
entries into the Source Log.

Listing the logs
Any log can be converted to ASCII text format, printed and/or saved to

the Mac’s disk. The printable listing is created by clicking on the Listing
button in the lower right of the Source Log window. All log windows have
the same button.

Loading
Once all entries to the Source Log have been made, the log can be used

to load all of the “tapes” into the Sonic. The procedure of loading differs
slightly, depending on the whether loading is done manually or using serial
machine control.

Wild loads
No particular preparations is need be made for manual loading, other

than to make sure that the source device is connected to the Sonic’s load
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port. Only soundfiles can be loaded in the manual process. The load pro-
cess is started by clicking on the Load button. The Record Soundfile dialog
appears, all ready to go.

Timed tapes & the Background Manager
Timed tapes are loaded automatically. All you have to do is make sure

that the tape or source reel is in the designated load machine. The External
Devices preferences sets up the 9 pin protocol to control both load and
dump transports.

For timed tapes, the progress of loading may be monitored by opening
the File>Managers>Background Manager…. Only Port 1 is used for load
and dump operations. The Background Manager is used for all 9 pin timed
(background) tasks.

Back to the Delivery Log
The Delivery Log is similar to the Source Log, except that the entries

underneath the Tape heading are EDLs instead of soundfiles. When the
Delivery Log is complete, the Dump command automatically transfers all
designated EDLs, in sequence, to a final delivery medium such as D2,
DAT or CD Printer. For timed tapes, the dump process is automated, other
than the need to change reels on the destination machine. Note that when
dumping the Delivery Log, the Sonic dumps only panels/tracks designated
as destination. If more panels are so designated than can be dumped, either
2 or 4 channels, the system will use the uppermost panels that are set to
destination.

The procedure for starting the Delivery Log is the same as for the Source
Log, except that the Dump button is used to start the process instead of the
Source button. If the Sonic is equipped with a CD Printer and PQ soft-
ware, the CD option may be selected, in addition to Wild Tape or Timed
Tape. Though there are two formats available for the CD output, always
use the Premaster format. It includes additional information that permits
perfect replication if the client desires. Also, is nice to know that the addi-
tional information is invisible to all CD players.

Adding tapes and EDLs
Adding other tapes or EDLs in the Delivery Log differs slightly from

adding them in the Source Log. To add another tape, choose “Tape” from
the Item popup menu. Click the Add button to add a new tape. To add an
EDL, double-click on the entry in the Delivery Log that lists the tape. The
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Item popup will change to say “EDL.” EDLs are specified by a name and a
start time. Click on the Add button which opens the Edit Decision List
Info dialog. Clicking on the “Name:” field in the Edit Decision List Info
dialog brings up the standard Mac Browser dialog to choose an EDL. Once
you’ve selected an EDL, you need to enter a start time. The Start Time for
the first EDL is normally specified as Absolute Time on the tape. This
value must not be set to less than the tape’s Start Time. A Start Time may
also be specified as the EDL Enter Time. This is the location of the first
audio sample in the destination tracks of the EDL. The Sonic automati-
cally enters the value when the radio button for that selection is clicked.
The Start Times for all EDLs after the first are specified in terms of a dura-
tion following the preceding EDL. This may be set as a fixed value (After
Previous EDL/Tape), as a standard value of 3 seconds (CD), or as STD.
The STD setting places the beginning of each EDL at an exact boundary
of 15 seconds (1 minute, 1 minute 15 seconds, 1 minute 30 seconds, etc.)
The system allows at least 15 seconds between each EDL.

After initial entry, the EDL may be reopened for editing, using the Edit
button. Note that when an entry is changed, the system may present the
user with a dialog warning that the “PQ information may be out of date.”
This message is relevant only for dumping to CD or DDP (Disc Descrip-
tor Protocol). Otherwise, ignore it. Once the Delivery Log is complete, it
may be transferred to the final delivery medium. The dump is started by
selecting the tape in the Delivery Log and clicking on the Dump button.
Unlike a dump to tape, CD or DDP dumps are SCSI transfers, not audio
transfers out of the dump port.

Wild dumps
If the Tape is specified as a Wild Tape, the Sonic assembles the EDLs in

the log and reports any errors to the user. Always set the absolute start time
of a Wild Tape to zero. Once the Delivery Log has been prepared for dump-
ing, the Sonic advises you to cue the record transport. Once it’s started,
click on OK to start the actual dump. As with machine controlled loading,
you can monitor the progress of the dump by using the Background Man-
ager. The dump port’s audio output can also be monitored via the Dump
assigns, usually B3/4, on the desk’s input.

Archives
Archives are created the same way as a dump including the use of an

Exabyte drive. Exabyte archives are double speed for stereo and quad speed
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for mono file. Like a CD dump, Exabyte archives are a SCSI transfer, not
audio sent out of the dump port. Being a data storage device, Exabyte tapes
are more reliable than DAT. They are also able to handle multichannel
audio. Note that you can also use a simple DAT without time code to
make an archive of stereo material.

If you must use a DAT, start with certified data grade blank tapes fresh
out of the wrapper. Make sure the tape transport is clean. Turn off all in-
puts on the Sonic and switch the Default Sample Rate to 48 kHz in the
File>Preferences>Audio I/O… clock master subdialog. This will shorten
the time it takes to archive 44.1 kHz soundfiles and the Sonic will restore
them just fine. Also, consumer DATs can only record at 48 kHz anyway.
Put only one archive on the tape to eliminate shuttling around which wears
out the tape.

Start the archive one minute into the tape to avoid problems near the
take-up hub. When your archive is finished, wind the head and click on
the Verify button. Enable the load port and feed the archive playback into
the Sonic. This will check the timing information used in place of time
code on the tape. If it fails to verify in the Background Manager, use the
tape for something else and start again with a fresh tape. Always make a
backup of the project and EDLs on a floppy. Lastly, store the floppy and
DAT in a sensible location.

Ten Steps to Archiving Bliss
For archiving to an AES audio device;

1) Always clock internally. This assures a stable frequency reference.

2) Disable all inputs. Again, this will prevent clock loops which en-
sures a stable time base.

3) Use a new tape, as short a length as possible. A new tape means
fewer dropouts and subsequent errors. The tape’s length dictates
the thickness and thicker tape is more robust. Finally, thicker tape
is dimensionally more stable which means the tape path is far more
predictable. Remember, DATs (and 8 mm) transports use rotary
heads.

4) Keep the transport clean, but don’t wear down those expensive heads.

5) Only one archive per tape means less shuttling and tape wear.

6) Buy data DAT media, not audio DAT media. Data media is usu-
ally less expensive and of higher quality than audio media.
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7) Roll, in record, past the first minute or two at the head. This will
ensure a stable tape path and consistent tape composition.

8) “Verify” the archive when completed. Why archive if you don’t
check the result?

9) Make a copy of all Macintosh files onto floppy. Floppies are rugged
and inexpensive. DATs are not designed for storing raw digital data.

10) Label & store the tape & floppy in a moderate temperature and
humidity environment.

What’s Under the Hood

• Preferences
Audio I/O
The Sonic has what seems to be a bewildering array of preferences. Well,

they are bewildering at first appearances. They are also essential for com-
fortable and efficient operation of your system. Learn to use them to your
advantage.

The AES/IEC channel status subdialog for a D–I/O box is there if you
need the Sonic to communicate with a cranky piece of digital gear. Low
cost “professional” products seem to be the worst offender in terms of tol-
erance to channel status variation. Channel status is subcode or non-audio
data carried in the AES stream that conveys global information about the
audio portion of the payload. Sample rate, emphasis and copy protection
flags are included and can be manipulated by the Sonic. Each Sonic output
is controlled individually by a corresponding AES/IEC button and reflects
the changes made in the AES/IEC dialog. So, one output can transmit
Consumer type and CD category flags while another is set to Professional
with Generate CRC enabled.

Specific settings are unimportant. Getting your gear to converse with
the Sonic is the goal. Try feeding the output from your DAT or other
ornery box into the Sonic. Click on the picture of the D–I/O and then the
AES/IEC button to reveal the AES/IEC subdialog. The Show Input but-
ton to reads the incoming flags. Click until the Sonic shows a green light.
Failure could mean operator error such as boxes not patched correctly or
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damaged cables. Once locked, click on the Write Template button to save
those setting to the Mac disk. Use a name that describes the external device
in question such as “SV-3700 Channel Status.” Once saved, you can use
the Read Template button to get the settings whenever you have difficulty
convincing your DAT to drop into record.

Finally, it’s a good idea to keep the Sonic inputs on only when you are
either recording or doing a mix to pix job. Otherwise, setting the clock to
internal 44.1 or 48 kHz will prevent clocking mishaps that could ruin your
day.

System
If you’ve looked in the preferences, you may have notices several popups

that are set to System. This setting, System or global time, is a convenient
way to ensure that all time parameters for the EDL, time code handling
and 9 pin devices are set to the same frequency and format.

EDL
A few things in this massive preferences dialog are worth looking at

again. In the Editing page, the Undo Depth setting may require more RAM
be assigned to the Sonic if you set it to greater than 30. In the Editing page,
the Editing Model should always be set for the largest number of channels
of material with which you expect to work. As an example, if you are work-
ing on a radio spot consisting of a mono voice over, stereo music bed and
stereo sound effects; set the editing model to the higher number of chan-
nels. That is, 2 for the stereo material, not 1 for the mono VO. Treat the
mono material as stereo.

A word more about the undo function in the Sonic. The first undo
command under the Edit menu is the Macintosh undo. This will only
undo display related functions. Moving the Gates or the waveform view
and zooming the waveform are covered under this command. Most every
other Sonic function is undone via the Edit>Undo Edit command. This
command is really the Undo Last Thing I Did command.

The Reel Rock page is very useful for making the Sonic more comfort-
able to use. You may want to enable EDL Only jog. The reason is that EDL
jog mode is much smoother and more responsive if the Sonic doesn’t have
to think about dragging a serially controlled machine around for the ride.
Try it in both modes and decide for yourself.
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• Status monitors
CD
A quick comment about the File>Status Monitors>CD Status… moni-

tor. CD prep is nicely covered in the user manual but remember to keep
that status monitor open whenever you are setting up a dump to CD. As
the dump progresses, that dialog will inform you of any problems along
the way.

Advanced DSP
• Sample rate conversion

Foreground vs background
Sample rate conversion (SRC) can be a real time process or can run out

of real time. The difference is that, when run out of real time, the Sonic can
use as much time as required to perform the calculations. More in-depth
calculations produce better fidelity. For flattest, most extended high fre-
quency response when background processing, increase the Number of
Multiplies in the Filter Parameters subdialog to maximum. Remember that
out of real time processes will only run in the background when an SCSI
Slave FX board is installed. SCSI Slaves are described in the addressing part
of the SCSI devices section above.

• Time domain modifications…twisting & pitching
Time Twist
Though it sounds like a funhouse ride, the best way to change the dura-

tion of a sound is to perform microsurgery, snipping out bits to shorten,
adding bits to lengthen. The Sonic can optionally perform this function
based on the amplitude of the sound, which makes sense for dialog and 
effects but doesn’t for music. Usually, you wouldn’t want music to
change tempo according loudness.

The Sonic can use Time Twist by itself or in conjunction with SRC to
provide pitch shifting. Either way, the operation can be either performed as
a discreet process via the DSP>TimeTwist>T.T. Specifications command
or as an edit in the EDL. As usual, specifications need to be defined; When
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using the discreet method, you enter parameters and launch the process.
With the editing method, you enter the parameters and Save As Default.
The Sonic uses the defaults during the edit. The ratio is set automatically
according to the placement of the edit points, usually a four point edit.

The single most important parameter is Quality. Something of a misno-
mer, quality refers to splice locations, not the character of the finished prod-
uct. A higher quality setting forces the Sonic to be more and more dis-
criminating in the splice locations it uses. For music, 0.1 is usually as high
as you can go and still not have changes in tempo. Speech and sound effects
can be spliced differently depending on loudness, so quality can be set up
to 0.8 or so.

The Max/Frame and Max/Silence values let you control splicing in the
loud portions (Frame) versus quiet (Silence). The Silence Threshold sets
the transition amplitude. A good threshold setting will make the difference
between an acceptable result and chopping off the heads or tails of words.
Turn on the Peak Hold box on the desk mix meters and gate a region of
quiet between words. Play>Between Gates to see how loud it is, then set
the threshold 2 dB above that value. Experiment on a short piece of mate-
rial to find the optimum settings for that material.

• Wrapping up
This collection of tidbits has covered the bare essentials of Sonic operation.

There are many, many topics that are not covered here since they are not funda-
mental aspects. Though the beauty of the Sonic System lies in the details, the
basic functions can be mastered in a short time. Hopefully, this collection of
information will speed the process of mastering the Sonic’s intricacies.
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Radio Application Specifics

Overview
We started out with coverage of information essential to any Sonic user. This

section discusses specific aspects of a broadcast production environment.

Prerequisites
• Sonic preferences

For this specific application, software preferences are an important part
of the optimal configuration. Since preferences are the “personality” of the
Sonic, particular settings can make the difference between a comfortable
work environment and an annoying one.

• Audio I/O Parameters — Generally, operation at greater than 16
bit is inaudible in the final product and wasteful of disk resources. So,
rounding should be off and input word length set to 16 bits. DC reject
should be enabled and set to at least 14 Hz to suppress sub-harmonic noise.

• System — The only item which requires consideration here is the
System Time Display setting, the global standard for time measurement in
the Sonic System. If such a thing exists, then the “house standard” should
be used. If none exists, then the default 30NDF is fine for 60 Hz countries
and 25 for facilities running on 50 Hz mains.

• Cue — A “CUE” folder needs to be made at the root level of the
HFS volume and the path set to that folder.

• Record Path — For improved handling of multiple jobs through
the facility, it is recommended that the Sound Disk selector be set by each
operator to a specific disk prior to the start of each job. This prevents the
Sonic from placing soundfiles for any one job on multiple disks.

• Edit List — The optimum number of panels in an EDL is dictated
by the nature of the finished product. Adding the number of discreet tracks
that make up the final audio to the largest number of channels that make
up the source soundfiles determines the minimum number of panels. A
few examples;
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Max. Number of
Source

Channels

Number of Final
Tracks

Min. Number of
Panels

1 1 2

2 2 4

2
6

(Act.s, Tracks &
Fx)

8

8 2 4 3 2

So, a very simple mono job should employ only a 2 panel EDL, one
source track and one destination. More commonly, four panels are used for
mono material. This enables an EDL to have 1 track each of dialog, music
and effects or one channel of voiceover (VO) and stereo actualities.

A typical stereo show with voice tracks, actualities and effects would use
an 8 panel EDL. A spot with mono VO, stereo bed and stereo effects would
also use an 8 panel with one panel probably remaining empty. 8 panels
would also accommodate one track of VO, stereo actualities and two or
three tracks left for room tone, walla or effects.

Show Times, being redundant, should be off.

The setting of Edit/Sync is dependant on the largest number of
channels that will be used in any source soundfile. Strictly mono soundfile
require that Edit/Sync be set to 1 while any mixture of mono and stereo
sources suggests that Edit/Sync be left at the default setting of 2.

It isn’t often that an editor wishes to have a 9 pin slave machine,
such as a time code DAT, follow the EDL master during jog or shuttle. For
this reason and to improve jog/shuttle performance, EDL Only Jog is usu-
ally enabled.

• Edit Fade — Both fades to and from black should be set for zero
overlap. This will enable rapid and precise placement of isolated segments.
Cross fades remain at 50% overlap.

Figure 12 -
Optimum EDL

Size
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Because room tone is often used to conceal otherwise problematic edits,
it is important to create the fifth default crossfade, the loop fade. Once set,
smooth loop transitions are more likely after the Loop and Fill command
than using the 20 ms default crossfades. To define the default loop fade,
open any soundfile into an EDL. Place edit points about 1 second apart
and Delete and Ripple with a crossfade. Gate the resulting fade and Edit
Fade…. In the Edit Fade dialog, make sure that both in and out fades are
selected and the overlap is 50%. Set the duration around 120 ms. Then, set
the dB Down to 4.2 dB and write that fade as “Loop Fade.” The name,
“Loop Fade,” ensures that this longer duration crossfade setting will be
used for Loop and Fill.

In addition, you often need to suppress an unwanted sound. However,
that sound may have a very short duration, too small for a delete & ripple
edit. In that situation, you need a special crossfade. This “ducking fade”
will drop the amplitude in the middle of the crossfade for as little as 2 ms;
enough to duck an unwanted transient. You could write out the setting for
later reuse.

Figure 13 - The
Ducking Fade
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To use this fade, place an In edit point right on top of the transient and
create a new crossfade under the Edit menu. Then, gate the fade and read
in the Ducking Fade setting. Adjust until the unwanted sound is suppressed
to your liking.

• Nudge — Nudge Factor is usually set from 2 to 5 frames to pro-
vide rapid repositioning of elements.

• Monitor — The USP mixing desk mode will dictate the number
of faders as well as the amount of EQ available on each strip. Mono work
only requires a four fader desk and a complicated stereo EDL benefits from
having 8 faders. Remember that four fader mode has twice the EQ “order”
per strip that an eight strip desk has. This order translates into slope of the
EQ or dB per octave. The shelving filters, for instance, have an 1st through
4th Order setting. This sets the steepness of the EQ curve, not the width
(which is set with the Q parameter).

The illustration below shows an averaged FFT of two filters; The soundfile
in the top panel is white noise passed through a 1st order parametric at 8
kHz with -24 dB of gain and a Q of 10. The soundfile in the bottom panel
passed through almost an identical filter. The only difference is the order
which was raised from 1st to 4th. Notice the slope or steepness of the
“valley,” 6 dB per octave versus 24 dB per octave.

 The desk has 16 orders of EQ per USP. So, a 4 strip mode desk has 4
orders per strip. An 8 strip desk has 2 orders per strip and a 16 wide desk
has only one. If you set, say, a third order filter on an 8 wide desk, you’ll
only hear a second order EQ even through the setting says 3rd order. You’d have
to shrink the desk down to 4 wide in order to get your 3rd order filter.

Operational Specifics
All broadcasting applications require the best quality of finished prod-

uct given severe time constraints. This implies that there is little or no
room for fastidious editing as in classical music production. “Quick and

Figure 14 - EQ
Slope

❢ ☞
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dirty” is the order of the day. While this is not always the case, consider-
ation should be made for a streamlined methodology.

The key to rapid assembly of finished product is use of both segment
and edit point editing where appropriate. The variety of audio used to
complete a typical spot or documentary demands using all tools at an editor’s
disposal. Any individual operator will have a different “comfort level” with
regard to the tools available. Introduction to advanced practices should
only be given once the basic techniques are mastered.

Traditional edit point editing is most efficient for creation of music beds
and piecewise assembly of elements into a continuous track. An example of
this would be a single speaker VO or walla track assembled from several
takes. Segment editing is best for the creation and placement of effects/
cues and isolated dialog elements. It is also efficient to use segment editing
in conjunction with the text display mode to split out dialog tracks.

• Editing
VO
Let us start out with assembly of a continuous track of VO. This presup-

poses that the EDL is set with all destination tracks set with the same sync
group, ensuring that they all play together by default. All of the soundfiles
that will be used in the job are opened from the Sonic Manager into indi-
vidual source tracks in the EDL. Opening rather than dragging the sound-
file into the EDL results in the soundfile’s name appearing in the track
number popup for future reference. Also, source tracks act as storage of the
complete raw soundfile. Audio is insert edited, copied or option–dragged
from the sources so the intact originals remains behind for reference, later
reuse and archiving.

Tracks
If the dialog track is the reference for the piece, then a zoom to entire (e

key) of the source and generously placed edit points allow an insert with
black fade to get a copy into the destination. An alternative is to copy, then
paste into the destination. The fade tool is used to visually trim the slate or
dead air off of the head A double click after the fade at the head and a Move
Left Gate to End will bring the tail of the track into view. Another trim
with the fade tool cleans up the tail and the basic track is complete in a
matter of moments. In either case, the Offset Left Edge command or the
segment tool slips the segment to the desired start time.
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The track now needs editing for content, pacing and overall timing.
A good choice here is to use the Analog Black To Marks command with a thresh-
old of -30 to -40 and a duration of 6 frames. The resulting marks allow you
to Create Segments In Place such that complete sections of dialog are iso-
lated. Any outtakes can then be selected (option–clicked), deleted and
rippled. It’s a good idea to place the gates around an example of representa-
tive analog noise to measure its loudness. Use the Play Between Gates com-
mand and look at those pre–fade meters on the desk strip. Use the ob-
served value for the Analog Black To Marks threshold.

The fade tool can reveal sounds removed by the delete process, approxi-
mating a more natural delivery. Remember, the shift and option keys, when
used in conjunction with the fade tool, allows you to select either black
fade component of a crossfade. A breath sound after a word, for instance,
can be “revealed” with the fade tool to fill in some dead air between words.

An alternative is simple two point delete and ripple edits to remove the
necessary pieces. Editing the resulting fade gets the pacing acceptable.

If additional work is required, such as replacement of a flubbed line or
inclusion of additional material, then the extra soundfiles are opened into
the next available empty source track(s). Standard 3 point insert edits, two
source edit points and an In in the destination, finish up the track.

Actualities
Actualities and sound effects are next. Once again, leave the entire raw

soundfile in the source track. Analog black to segment marks followed by
creation of segments in place will allow cutting/pasting or option–drag-
ging into the next track under the dialog. Since the destination tracks are
all in the same sync group, the composite mix always plays together. A
control–play lets you isolate any track for solo playback.

Actualities come together that same way as dialog. Selection of a seg-
ment in the source track followed by a copy command, allows you to paste
the copy to an edit point in the destination. Play the destination and tap
the [ key to “drop” an In edit point where you hear the segment should go.
Remember to select the correct panel prior to placing the edit point. The
Create Segments From Gates command is handy when you need to quickly
make a segment. It’s quite common that segments in one track need to be
moved on the timeline to “make room” for audio on an adjacent track. The
following illustration shows a track of dialog be dragged later in time to the
right in order to give the actualities on track 2 some room to be heard.

❢ ☞
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The Select Segment> Left Gate to End is the ideal command in this
situation. Be sure to deselect all segments before using it.

Check out a few details; The left edge of the selected segments in track 1
is being visually lined with the right edge of the segment sitting in the
middle of track 2. Also notice that panel 1, 2 and 3 are all set to the None
edit group though they’re all in the A sync group. This is the most efficient
way to work on multitrack mono jobs since you aren’t constrained by edit
group settings but they always play together by default. Remember that the
control key overrides that sync group setting, even from the Transport Panel.

• Effects and cues
What Sonic calls “cues”
Effects are special in that you often reuse them and the same sound may

appear many times in different places in an EDL. That means it’s cue time.
Cues are best for audio that will be reused more than once. Effects, bumpers,
open/close themes, station IDs and other bits that keep getting reused should
be made into cues for further recycling.

Figure 15 -
Dragging Seg-

ments
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Figure 16 -
Search Info for

Cues in the
Finder

Creation & use
Open the raw effect soundfile into an empty source track. Analog black to

segment marks followed by creation of segments with delete will result in quick
isolation of each effect. Audio from CD libraries usually has the equivalent of
digital black between cuts so the threshold can be set for -90. For field record-
ings, you may want to gate a sample piece to test your threshold setting before
marking the whole track.

Now that each effect is distinct, switch to text viewing mode and click on
the name of the first segment. Tap the space bar to listen to it, then tap to stop
play. The enter key brings up the current name allowing you to rename it
appropriately. Another enter hit closes the dialog and the down arrow moves to
the next segment. Start the process again, listening and naming, until you’re
done. Now, all segments should be named and ready for inclusion in the Cue
Library. You may want to make a separate folder for different types of cues;
maybe one each for music and subclasses of effects. If so, set the Cue Path
preferences before going on. Select the appropriate segments, usually all in that
track, and Make Cue Files under the Edit menu. After that, you can cut out
those segments and go on to the next task; making more cues or finishing up
the EDL.

The Cue Placement palette is the key to spotting those stings and effects you
made. But, before you place them, you have to find them! That is, you have to
identify which cue you want. The Find file utility in the Mac allows you locate
the range of cues that match a particular need. This requires, however, that you
either give the cue a very detailed name or, as shown below, you enter key
words in the Comment field of that file’s Info window. If you’re running Sys-
tem 7.5.2 or older, Comment fields are erased when you rebuild the Desktop
file, which you should do about 4 or 6 times a year. Otherwise, the Comments
field is preserved through a Desktop rebuild.
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In the figure above, I have two folders containing cues sitting on the
Desktop; one for music beds and one for effects. The handy System 7
control panel called Window Shade, built into System 8, was used to “roll
up” the Beds folder to get it out of the way. Its useful to keep different types
of cues segregated in this manner. Just remember that the Cue Path prefer-
ence can only be set to point at one folder. That path is for creating cues.
You can drag them into another folder after they’re made to keep things
organized.

Once you’ve organized your cues and picked one for placement, the
Placement palette provides the necessary control over it’s location. Its simple
and efficient. The time stamp option rarely makes sense for radio work so
the first three modes are the ones most commonly used. The Play Head
mode is great because you can leave an existing In edit points alone and still
place a cue.

• Double speed play
The concept
Wouldn’t it be nice if you could play back a long dialog take at higher

speed than normal without sacrificing inteligiblity? You can, though at
present you need a USP and the sample rate conversion option to do it.
The idea is to have the Sonic varispeed the output to up to double the
playback rate at which the soundfile was recorded.

Assuming you have the aforementioned prerequisites, all you have to do
is change the Desk mode and then start varispeed on playback. In the
File>Preferences>Audio I/O Preferences dialog, click on the big USP pic-
ture button and set 2 Channel Only mode. OK your way out of that dialog
and the desk repatches to its smallest size possible. The minimal desk al-
lows the Sonic to “steal” the processing power for double speed playback.
Next, open the Play>Varispeed On Playback dialog, click on Custom and
delete the existing value. Finally, any value down to half the actual sample
rate and click it On. The lower the value, the faster the audio plays back.

Once the material is finished, you will have to play it out. The Instant
Play option lets you audition without the usual hesitation before hearing
sound as you get with a space bar play. Instant play uses the Pause button
on the transport panel to fill the disk buffer ahead of time rather than after
the Sonic receives a play command. In the File>Preferences>Audio I/O
Preferences dialog, click on the picture of the USP. In the resulting subdia-
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log, click on the Instant Play checkbox. This feature works best with 2 or 4
wide desks. Once the option is enabled, use the transport panel to locate to
a play time. Clicking on the pause button will fill the disk buffer so just
take the EDL out of play/pause to start instantly playing.

• Wrapping up
This section has covered the bare essentials of radio operation and require-

ments. There are many, more involved topics that are not covered. The moti-
vated reader is invited to dive into the user manuals for more in–depth coverage.
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NoNOISE Application Specifics

Overview
The first section, Sonic Essentials, starts out with coverage of information

essential to any Sonic user. This section discusses specific aspects of a NoNOISE
production environment.

Prerequisites
• Sonic preferences

For NoNOISE, there are no specific software preferences. Settings de-
pend mainly on the working style of the operator.

Operational Specifics
NoNOISE applications require a fine balance between quality of fin-

ished product and time spent to achieve an acceptable result. The client’s
expectations can vary so widely. What is perfect for one is trash for another.
Nowhere else is this more evident than a comparison between a forensic
job and a 78 restoration project. In the case of most forensic audio, you’re
lucky if the final product has any intelligible dialog at all. With a restora-
tion of an old music recording, you must weigh the amount and types of
processing against the expectations and memories of a wider audience.

A typical job begins with a discussion of what is expected for the final
audio. How much processing? How much time & money? More time usu-
ally means a better product at a higher final cost, either to the client or the
operator. Do you want it quiet or close to the original timbre? The more
that the material is “stepped on,” the less it sounds like the original.

Next the material is loaded into the Sonic. This means the signal has to
be converted first to analog, then to digital. It is at this stage that you must
try very hard to get as high fidelity a transfer as possible. Garbage in equals
garbage out and it takes a long time to make garbage sound good!
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• Mechanical transfers
Preparation
For mechanical recordings, start with the cleanest media possible. If you

have access to a record cleaning machine, use it. Dirt on the recording
means more decrackling is needed. Depending on the individual record-
ing, you may want to lubricate the surface either with an aqueous polymer
or silicone preparation. The aqueous products tend to promote less dust
buildup after the treatment than sticky silicone. Also, for plastic substrates,
the polymers will help to improve the elasticity of the plastic which de-
grades after time and exposure to ozone.

Speaking of elasticity, plastic materials deform one of two ways. When-
ever you play a record, you are deforming the groove. If the deformation is
minor, the plastic will relax back to it’s original shape given sufficient time.
If the shape is altered too drastically, then the change is permanent. It all
comes down to how much is too much.

If you setup your arm and cartridge correctly and play a clean LP once
in 24 hours, the vinyl has time to largely relax back to it’s original state.
More often than that and the vinyl doesn’t flow back to the way it was
pressed. Groove wall damage is the result. Prior to the use of vinyl, records
were made of harder plastic and are more prone to damage from repeated
plays. Lacquer and wax recordings need only a light touch before they de-
form. You cannot play them without some damage.

Let’s talk about stylus tracking force. Contrary to intuition, you should
set the tracking force at the upper limit of the cartridge’s rating. This will
prevent the stylus from leaving the groove during play. A light tracking
force will allow the stylus to “launch” into the air, float momentarily, then
smash into the record surface. Bouncing up again and again, it gouges the
surface each time it lands. Needless to say, this ain’t good for the record.

Also, a light tracking force can have another unwanted effect. Depend-
ing on the cantilever/cartridge compliance, insufficient tracking force al-
lows the stylus to oscillate at high frequency. Modern high compliance
assemblies have more tendency to oscillate than stiff ones.

Stylus selection
The stylus geometry should be chosen either to match the groove shape

or to find untouched real estate. The former is simple; conical, elliptical or
hyperelliptical variants are designed for a particular format and era. A mi-
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croscope can help you choose a size and shape to match the groove wall.
But what if you don’t want to!

Many phonograph records were played with less than optimum track-
ing and antiskate force. Also, the record probably wasn’t clean most of the
time. The result is groove wall damage or dirt becoming embedded in the
groove. A stylus that matches the geometry of previous playback equip-
ment will also follow the same path traveled by that previous playback
equipment. The result is a distorted transfer. If the original equipment was
conical, then a smaller diameter line contact stylus would travel in a region
of the groove that hadn’t been touched by ancient styli. If your lucky, the
result is a cleaner transfer.

Electrical considerations
The question of “proper” EQ and deemphasis is beyond the scope of

this discussion but be advised that the DeRIAA filter on the desk is prob-
ably more accurate and has lower phase distortion than most analog phono
preamps. So, it may be worth the effort to transfer and digitize flat and
apply the filter in the Sonic.

• NoNOISE work flow
The processing of soundfiles always progresses in a predictable order.

First, complex filtering is used to remove unwanted frequencies and noise.
Next, production declicking removes most transient noises and manual
declicking removes what’s left. Decrackling reduces distortion and broad-
band denoising finishes up what’s left. A final filter and reverb pass finish
the job. Each individual process is optional but the order of processing
steps taken is always the same.

Naming & saving
All NoNOISE processes, with the exception of declicking, create new

soundfiles. They also usually require that you save a settings file as well. It’s
not unusual to spawn 10 or 20 “children” from each “parent.” To help
maintain your sanity, it’s very important to adhere to a strict naming con-
vention. Start by making a new folder on the HFS disk with the name of
the client. Place that folder on the Desktop. All settings files will be saved
into the client folder and the child soundfiles will go into the parent
soundfile’s folder. Since the order of processing is preordained, then why
not simply call all soundfiles 1stEQ, 1stDc, 2ndDc, 1stDk 2ndDk and
1stDn, etcetera.
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Filter
Complex filtering usually starts with a careful listen. Most old re-

cordings have a large amount of low frequency energy that can be re-
moved without detriment. Try using a 3rd order low pass filter to find
where the program ends and the rumble and AC hum begins. Set Fil-
ter…, open a third order high pass and enter the resonant frequency
that you found on the desk’s EQ. Simple enough but now the fun be-
gins.

Supposed the soundfile has significant amounts of AC–derived noise.
It may take 300 or more individual filters to reduce that contamination
to a acceptable level. For fixed frequency noise, such as AC hum and
buzz as well as acoustic camera noise HVAC and motor noise, a collec-
tion of filters is needed to suppress many frequencies at once. Let’s start
with an FFT or Fast Fourier Transform. FFTs in the EDL let you “see”
in the frequency rather than time domain as you normally would. You
can visually identify problems and design a filter set to suppress the
offending signal.

Listen to the audio and find around 0.5 to 1.0 second of representa-
tive noise floor. Of course, this may be impossible so do the best you
can with what you’re given. Place the Gates around the area of interest
and drop a segment start and end mark to identify where the Gates
have been. Then, do a frequency analysis under the DSP menu. The
resulting FFT might look like this…

Figure 18 - An
FFT Display

Figure 17 -
NoNOISE

Naming Conven-
tions
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The peaks rising above the noise floor is 60 cycle buzz. We need to know at
what frequencies these noises occur and how wide a range of frequencies are
occupied by the noise. The easiest was is to measure it directly. First thing to do
is switch global time over to seconds. When the EDL is set to seconds, the
Gates measure frequency and bandwidth directly in the FFT. Bring up the
Transport Panel, click on SYS and go to the display time popup.

Click–hold and select seconds as the display method. The EDL should switch
to a timeline in seconds. Now, the two time fields for the left and right Gate in
the EDL’s toolbar display the Gate’s position as frequency. The time field in the
middle can measure the difference in the Gates position in Hertz as well. So,
let’s measure the center frequency and bandwidth on one of the noise peaks.

Point to a noise peak and double click; The Gates jump right over to the
spot. Place the left Gate in the middle of the peak and the right gate at the
upper frequency limit of the peak. The center time field shows one half of the
bandwidth and the left Gate time field shows the center frequency. The illus-
tration shows a center frequency of 1141.28 Hertz and bandwidth of 2.825
time two (because the value is half of the total bandwidth) or 5.65 Hertz.

Figure 19 -
Changing Global

Time

Figure 20 -
Measuring

Frequency and
Bandwidth
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We can also figure how much gain is needed for a filter to suppress
this noise. Compare the peak amplitude to the surrounding noise floor.
In the above illustration, there’s about a 20 dB difference. If we sub-
tract 3 or 4 dB, just to be on the safe side, we get 16 or 17 dB. So, a
perfect setting for this filter would be a 4th order parametric with -16
dB of gain, a center frequency of 1141.3 and bandwidth of 6 Hz. Trouble
is, the complex filter dialog requires the bandwidth to be express as Q
or quality factor, not absolute bandwidth. Q equals center frequency
divided by bandwidth or, in this case, a Q of 190 (1141.3 Hz/6 Hz).
All those parameters are entered into the complex filter dialog. I should
mention that a Q of 190 is usually too narrow for the real world. You’d
probably want to reduce the setting to 80 or 120 to prevent ringing.

As you can see from all those spikes sticking up in figure 18, there
are multiple harmonics of 60 Hz present in the audio. To reduce the
hum, you must suppress each harmonic. This may require several hun-
dred individual 4th order filters. Needless to say, it would be impracti-
cal to measure each one by hand. Fortunately, big science has come to
the rescue in the form of the spreadsheet application. While the details
are beyond the scope of this discussion, it is quite easy to measure only
the fundamental and 2nd through 5th harmonics. This gives you five
data points which allow you to predict where and what the remaining
filter settings should be.

Once you have either manually measured or predicted all of the de-
sired settings, these must be manually entered into the complex filter
dialog along with the high pass filter discussed earlier. The resulting
soundfile should be placed in the parent soundfiles folder.

Figure 21 -
Quality Factor

Calculator
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The Filter… dialog allows you to process a portion of the whole
soundfile by changing the start and end times. This feature saves
you significant time. Choose a 15 to 25 second “test sample” of the
original soundfile and filter only that. The resulting filtered file
will be used for all further processing. Try to find a region of the
original soundfile that has silence as well as loud program. This
will make later steps easier.

Because of the test sample’s short duration, all further process-
ing will finish very quickly. This means you can experiment with
settings and hear the results much faster than working on the en-
tire length of the original. The only caveat is that whatever param-
eters you decide are best must be saved with a sensible name for later
reuse. At the end of the test sample’s processing, you apply those
same parameters to the entire original file in the background.

Notice that nothing has been said about a low pass to remove
high frequency (HF) noise. Our hearing acuity is so poor at very
low frequencies (LF) that removing spurious low frequency noise
doesn’t affect the timbre of a signal if done carefully. This isn’t true,
however, at high frequencies. Our brain interprets a low pass filter
as loss of actual program even if the material in question has no HF
content. We’re fooled into thinking that HF noise is useful audio.
The broadband denoiser does a fine job of suppressing HF noise so
don’t use filters for that problem. Of course, in forensic work, any-
thing that helps is OK.

❢ ☞

Figure 21 -
DMFS File
Placement
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Production declicking
On to declicking. The production declicker is best used to re-

move clicks of similar duration in successive passes. This may mean
one, two or twenty click detects each followed by a declick pass.
The idea is to remove, in each pass, clicks of similar duration so
that the regions of repair (interpolations) are only as long as neces-
sary. The following table gives a general idea of what a three pass
process would use for settings. The wide range of variation takes
into account the need to do somewhere between two and twelve
detect and declick passes to prepare the file for decrackling. In gen-
eral, lower values in each range are used with the exception of wing

width and weight, where higher values are preferred.

Detect Pass Initial Threshold Center Width Wing Width Wing Weight
(measure longest click)

1st 150–450 0.0016–0.016 0.0025-0.0068 1.0
2nd 30–150 0.00125 0.0015-0.003 0.8–0.9
3rd 1–30 0.0008–0.0009 0.001-0.0025 0.5–0.8

Declick Pass Replacement Width Threshold

1st 0.0032–0.032 set “Threshold” using Initial Threshold value
2nd 0.0025 set “Threshold” using Initial Threshold value
3rd 0.0016–0.0018 set “Threshold” using Initial Threshold value

After several declick passes, the number of interpolations can become
quite high. This reduces the likelihood of further repairs because Sonic will
not perform a repair if the new interpolation touches an existing one. The
best thing to do is capture the file and continue working on the captured
one.

Manual declicking
Once the production declicking process is exhausted, there will still be a

few audible clicks. Often, these are interpolations which sound as bad as

Table 1 - Basic
Declicking

Settings
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the clicks they are meant to replace. For these and legitimate clicks which
were somehow passed over, the manual declicker is used.

Though the B type algorithm will always work, it isn’t the best one to
use in all situations. The C type is best for waveforms that visually repeat in
time. The D and E type are both variations on the decrackling algorithm.
The D type is best for waveforms that have some visually repetition with
some variation in each period or repetition. If the waveform is highly peri-
odic, use the C type and if it’s random, use the B type. In between wave-
forms get the D type.

A problem with the D type is it’s inability to repair long duration clicks.
Any repair longer than 11 ms is likely to fail and you’ll wait a long time to
find that out. If you want to use the D type but the duration is too long,
then use the A type instead.

The E type is a manual decrackler that will process even the longest
segment, as long as you’re willing to wait. The E type will remove or mini-
mize distortion, acting as a miniature production declicker. It locates and
repairs problem areas on a microscopic scale, but it runs extremely slowly.
As with all of the manual declicking functions, once they are started you
can’t stop them.

When using the A, B, C or D types, be sure to set the Gates such that
they generously contain the click. Any “invisible” low frequency portion of
the click left outside the Gates will be used in the interpolation, producing a
bad sounding repair.

One last comment about declicking. You need not get all of the clicks
out of a file. The decrackler will remove any small clicks that are left. How-
ever, best results are obtained by using the appropriate method. Let the
declicker do it’s job so the decrackler won’t have to work so hard.

Decrackling
The decrackler has only two controls that are commonly used. One is

clip fraction and the other is synthesis order. Clip fraction sets the amount
of repair and synthesis order tells it how precise it should be.

A high percentage of repair (20–25% or clip fraction of 0.8–0.75) dic-
tates a low precision at the default 75 setting. So, if you do two or three
passes at a clip fraction of 0.92-0.94, you can use a higher synthesis order
(120–150). The difference is subtle but worth it for good quality material.

Remember that the file produced by the complex filter pass, “1stEQ,” is
the one you would use. It has already been declicked and is ready for
decrackling. Like complex filtering, the decrackle process makes a new

❢ ☞
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soundfile. For each pass through the process, you should use the soundfile
resulting from the previous pass. As shown in figure 22 below, the child
soundfiles are placed in the parent folder. 1stDk, 2ndDk and 3rdDk are
good names for these files.

Too much decrackling results in subjective loss of high frequency con-
tent. Since the test soundfile is of short duration, you can try a few passes
and decide how much decrackling is enough.

Denoising
The denoiser is a collection of bandpass filters followed by expanders.

The bandpass filters break the entire 20–20 kHz passband into 100 Hz–
wide “bin” or frequency bands for fine control by the expanders that fol-
low. The processing starts with an averaged FFT or “estimate” to determine
the amplitude threshold setting for each bin. Ideally, you should take the
estimate in a half second spot in the soundfile where there is no signal, just
noise floor. Interpolate the estimate and save the estimate file. If you have
no silent passage to work with, then you need to use the more complex Fit
Estimate command which is discussed in the user manual. Once the esti-
mate is saved away then you can launch real time denoising (RT DN).

The broadband denoiser only works if the noise floor doesn’t change
appreciably over time. If the noise floor does shift in amplitude or timbre,
then the material needs to be sliced up into pieces such that the noise is
constant within that piece.

Prior to launching RT DN, you need to patch the process into the moni-
tor path. The insert patch points on the desk are used. I1 for a single effects

Figure 22 -
More DMFS File

Placement
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board and I2 for a second effects board. Unused main boards can be en-
listed for this purpose as well.

You may notice a echo or time difference between strips that have RTDN
inserted and those that do not. The difference is the propagation delay or
amount of time that the RTDN process requires. That delay is perported
to be 0.20912 seconds or 9222 samples, though I haven’t measured it.

Once patched, launch the RT DN process and open your estimate in
the resulting dialog. Set the faders as follows, then take the process out of
bypass;

Threshold -60 Attenuation -40 Sharpness 1.25
Bandwidth 1.94 Cutoff 200

At this point, the process should be very audible. Since the test sample is
quite short, you may want to loop and fill an empty track with several
copies. Track 1 in your EDL is probably empty so, set track 1 (and 2) to the
destination edit group. Place edit points at the head and tail of the sample
soundfile and set that track to source. With the source panel(s) selected,
Loop & Fill to make ten copies in the destination. Use this track for setting
your RT DN parameters. An alternative is to go back to the original soundfile
and apply all previous processing steps in the correct order. This will pro-
duce the whole soundfile, ready for denoising instead of the sample.

What is needed at this point is a reasonable threshold setting from which
to work. Using the transport panel, play the EDL and adjust the threshold
so that the quiet material is being noise reduced and the loud stuff is left
alone. Usual this is in the 11 to 16 range. Next, back off on the attenuation
to provide a pleasing compromise between noise reduction and artifacts.
Subsequent small adjustments to both threshold and attenuation are made
until the sound quality is acceptable.

Figure 23 -
Insert Patch Point

on Desk

Table 2 - Basic
Realtime Denoise

Settings
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The other three parameters, though important for discerning custom-
ers, are often left at the setting described above. When you have found
parameters that work for your application, save those parameters so you
can process the file in the background.

Final EQ
Often it is helpful to perform another filter pass on the audio before

calling it quits. This allows you to tailor the frequency response slightly to
compensate for all of the processing you’ve done on the material. A slight
boost in the 4 to 7 kHz region can give the audio a sense of extended high
end that it may be lacking.

• Wrapping up
This collection of tidbits covers the bare essentials of NoNOISE operation.

Realistically, quality NoNOISE work is a craft that requires critical listening
skills and plain ol’ experience. Critical listening can be learned…so start logging
those hours!
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CD Prep Application Specifics

Overview
The first section in this document, Sonic Essentials, provides (surprise!) infor-

mation essential to any Sonic user. This section discusses specific aspects of a
Red Book CD production environment.

Prerequisites
• Sonic preferences

For this application, only the default black fades must be set to insure
accurate results. There are several other settings, however, that can improve
quality and productivity.

• Audio I/O — The USP mixing desk mode will dictate the number
of faders as well as the amount of EQ available on each strip. Stereo work
only requires a four fader desk. Remember that four strip mode has four
orders of EQ per strip. Order translates into slope, measured in dB per
octave, of the EQ. The shelving filters, for instance, have an 1st through
4th order adjustment. This sets the steepness of the EQ curve, not the
width, which is set with the Q parameter.

The illustration below shows an averaged FFT of two filters; The soundfile
in the top panel is white noise passed through a 1st order parametric at 8
kHz with -24 dB of gain and a Q of 10. The soundfile in the bottom panel
passed through almost an identical filter. The only difference is the order
which was raised from 1st to 4th. Notice the slope or steepness of the
“valley,” 6 dB per octave versus 24 dB per octave.

Figure 24 - Visual
example of Quality

Factor
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The entire desk has 16 orders of EQ available. So, a 4 strip mode desk
has 4 orders per strip. If you set first a 3rd order filter, then a 2nd order
filter on a 4–wide desk, you’ll only hear the 3rd order EQ properly. The 2nd
order filter will act as a 1st order even through the setting says 2nd order be-
cause you have exceeded the EQ capacity of that strip. You’d have to cascade
the desk in order to get your five orders of EQ. Cascading is described later
in this section. By the way, the dynamics processor in the first EQ section
is “free.” That is, it doesn’t use up any of the 4 EQ orders mentioned above.

• Audio I/O Parameters — Unless the material warrants, DC reject
should be enabled and set to 14 Hz to suppress sub-harmonic contamina-
tion. Usually, a recording will have signal below 20 Hz but often such
subsonic energy is only from air conditioning or structural–born noise.

Increasingly, recordings originate with word lengths greater than 16 bits.
So, rounding should be off and input word length set to the length of the
incoming material.

Both the AES data stream and Sonic carry 24 bits of precision. In the
Sonic, word length for data both in and out can be limited to a specific
word length less than or equal to 24 bits. Rounding allows low order “ex-
tra” bits to be rounded into the least significant bit (LSB). For example, a
16 bit A/D converter has only 16 usable bits so, with the input word length
set to 16, rounding would “carry” any information in the 17th through
24th bits and use that value to modify the 16th bit. Since those low order
bits have only random garbage data in them, this would not be a good
thing to do. In fact, some converters use those extra bits in the AES stream
to pass non–audio control information. It wouldn’t be good to round that
stuff into the LSB.

Emphasized audio and long word length recordings, from 18 or 20 bit
converters, require special handling. For emphazised material destined for
CD distribution, the audio should remain emphasized throughout the en-
tire production cycle. If the PQ codes are set correctly, the CD player will
deemphasize the material on playback. This approach, which makes sense
for acoustic recordings or material with “natural” spectral energy, affords a
modest improvement in the high frequency signal to noise ratio. The Sonic
has an optional deemphasis filter on the desk to monitor emphasized mate-
rial correctly.

Long word length recordings also require a bit (or byte?) of extra dilligence
on your part. Someone must decide what to do with the extra data. One
approach is to load and process the material at full word length. For final
delivery, the data can be truncated or redithered and reduced in length to

❢ ☞
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suit the delivery medium. The latter approach makes sense most of the
time. Truncation sounds right to some folks and also makes sense when the
audio will go out to ultralow fidelity distribution, such as web browsers or
cartridge–based games.

Since mastering usually requires preservation of the fidelity of the mas-
ter recording, the dither setting is very important. Anytime gain is changed
or two or more audio streams are mixed, then the resulting data should,
theoretically, be redithered for lowest distortion in the final product. To
put it another way, if the data word is changed in any way, then that data
should be redithered. Given that information, there isn’t much you can do
that won’t benefit from redithering! Normalizing, panning, EQ or apply-
ing black fades during editing all require redithering. However, redithering
improves distortion at the expense of increased noise. You don’t get some-
thing for nothing…

A basic SonicStudio has two dither spectra from which to choose. The
most basic is the white or “flat” spectrum choice, which is useful if your
audio will be played back at a sample rate other than that at which it was
recorded. An example would be voices for a synth library.

A second choice, preferable for most situations, is to dither using a
weighted spectrum. While the overall energy remains the same, the midband
energy is lower. This means the dither noise is less audible than the flat
spectrum version.

You also get to choose the turn–on criterion for the dither generator.
Ideally, you want best linearity (lowest distortion) for changed audio data
while leaving unchanged samples unsullied. This approach requires 100 %
output dither with the bit resolution switch–on criterion selected.

Lest we forget, dither is noise! At times, noise is the last thing that you
want to add to the mix. In other situations, you may want to mask a less
than ideal recording. There are several third party manufacturers of dither
generators and each device has a different “color.” Some are good at ob-
scuring low amplitude information while others remove the veil, revealing
the quietest sounds.

Before we leave I/O Parameters, check to make sure the Default Sam-
pling Rate is 44.1 kHz. Incoming material at rates other than 44.1 need to
be sample rate converted externally or by the Sonic, preferrable in the back-
ground for flattest frequency response.

• Desk Parameters — For 18 and 20 bit bounces back to disk, the
resolution or word length setting of the monitor section is crucial for cap-
turing the highest possible fidelity without truncation. Normally, the moni-

❢ ☞
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tor path through the Sonic (the mix desk) is 20 bits “wide,” with 4 bits of
gain available on the strip faders. This means that truncation errors would
accumulate if long word length audio was processed through the desk on
the way to final delivery. As the dialog’s title implies, the desk can trade off
word length for gain, so the desk resolution should be increased to at least
2 bits (12 dB) greater than the word length of the material to be processed.

If you use automation, you probably want to start a session in read (“play-
back”) rather write mode. All though not a part of desk defaults, the
Desk>Fine Desk Control toggle is useful for, as the name implies, fine
adjustments of gain. The control key is a temporary equivalent.

• System — The only item which requires consideration here is the
System Time Display setting, the global standard for time measurement in
the Sonic System. For all CD prep work, the 30 non–drop frame setting
must be used. This is the international CD standard, overriding any local
variations of line or video frequency.

• Cue — A “CUE” folder needs to be made at the root level of the
HFS volume and the path set to that folder. This feature, though seldom
used in CD prep, will satisfy the Sonic’s requirement that the path be set.

• Record Path — For improved handling of multiple jobs through
your facility, it is recommended that the Sound Disk selector be set by each
operator to a specific disk prior to the start of each job. This prevents the
Sonic from placing soundfiles for any one job on multiple disks. Another
approach, with a multidisk system, is to unmount any unused disks to
prevent their use when the Sonic is in Auto disk selection mode.

• Edit List — The optimum number of panels for a stereo edit is
four. So, the default is fine. Show Times, being redundant, should be off.
Edit/Sync should be left at the default setting of 2. The default Zoom
Times value is a bit generous for precise editing, so you may want to drop
it down to 0.65 seconds or less.

In CD prep, it makes little sense to have a 9 pin slave machine,
such as a time code DAT, follow the EDL master during jog or shuttle. For
this reason and to improve jog/shuttle performance, EDL Only Jog is usu-
ally enabled.

• Edit Fade — Since most CDs are assembled with edited black be-
tween each audio track, the default black fade setting is critical to accurate
creation of PQ codes. Both fades to and from black should be set for zero
percent overlap. Cross fades remain at fifty percent overlap.
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Because some artists or producers wish to fill intertrack audio
with analog noise, it is important to create the fifth default crossfade,
the loop fade. Once set, smooth loop transitions are more likely after
the Loop and Fill command than using the 20 ms default crossfades.
Loop and Fill is also useful for creating repetative backing or rhythm
tracks for dance and ambient mixes. The following is a rehash of the
same information from the Prerequisites section early in the Radio Ap-
plication Specifics chapter.

To define the default loop fade, open any soundfile into an EDL.
Place edit points about 1 second apart and Delete and Ripple with a
crossfade. Gate the resulting fade and Edit Fade…. In the Edit Fade
dialog, make sure that both in and out fades are selected and the over-
lap is 50%. Set the duration around 120 ms. Then, set the dB Down to
4.2 dB and write that fade as “Loop Fade.” The name, “Loop Fade,”
ensures that this longer duration crossfade setting will be used for Loop
and Fill.

In addition, you often need to suppress an unwanted sound. How-
ever, that sound may have a very short duration, too small for a delete
& ripple edit. In that situation, you need a special crossfade. This “duck-
ing fade” will drop the amplitude in the middle of the crossfade for as
little as 2 ms; enough to duck an unwanted transient. You could write
out the setting for later reuse.

Figure 25 -
That Loop Fade

Again
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To use this fade, place an In edit point right on top of the transient and
create a new crossfade under the Edit menu. Then, gate the fade and read
in the Ducking Fade setting. Adjust until the unwanted sound is suppressed
to your liking.

• Nudge — Nudge Factor is usually set from 40 subframes to 1 frame
for accurate repositioning of segments.

Operational Specifics
CD prep is a detail oriented exercise in precision editing and EQ.

Premastering, the objective preparation of audio for transfer to CD, differs
from mastering where subjective “taste” judgements come into play. A dis-
cussion of mastering is beyond the scope of this journey, but some thoughts
on premastering essentials follow…

Since Sonic “assumes” a stereo delivery, the EDL layout should be 4
panels with stereo destinations in panels 1 and 2 and stereo sources in 3
and 4. All sequencing should be done with black fades at the head and tail
of each track to assure the most accurate placement of Start (SOT) and
End of Track (EOT) marks. Sonic uses your placement of these marks to
automatically generate the P & Q subcodes.

To place the first song on the CD into track 1 and 2, use an Insert and
Ripple with Black Fade. No edit points in the destination are needed. Sonic
will snug the first sample right up against zero in the destination timeline.
If Sonic pops up an error dialog mumbling about a negative start time,
then your default fades are set incorrectly. In the previous section under
Edit Fade, I mention that you should set your default black fades to 0%
overlap.

After the first song is in place, you can play past the end of the song and
tap the [ key to place an In edit point for the next song based on “feel.” If
variable spacing between song is not what required, you can use one of the
QuicKey sequences to quickly place a fixed amount of black between songs.
Point inside the last segment in the track and double click to park the
Gates between the black fades delimiting the segment. Then type shift–
control 1, 2 or 3 for 1, 2 or 3 seconds of black between the last sample and
the In edit point. Then, just mark the source material with edit points and
Insert with Black Fade. The shift–control 1, 2 or 3 command mentioned
above assumes you’re using the current QuicKey keyset.
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Once the sequencing is completed, you may need song to song EQ and
level correction. First, adjust gain on each song relative to it’s neighbor. At
this point, you should select all segments (⌘  - d) and normalize the
whole track. This will ensure that you’ve taken full advantage of the dy-
namic range available. If you are planning to use automation during the
dump to CD, a “desk dump,” then wait until later to do relative gain cor-
rection using the desk’s faders.

If your EQ is automated, you can do that during the desk dump as well.
If not, then capture the material with EQ right into the destination tracks.
See figure 9 and the EDL and recording part of the Advanced Editing
section for a review of capturing.

As promised; a word about cascading EQ on the desk. Most of the time,
you would run the desk in 4 strip mode. You would then be using two of
the four strips for stereo material. The other two strip are not buying you
anything. Instead, try setting the I/O patching as follows; M1, M2, M3,
M4, C1, C2, A1, A2. This “cascaded” patching allows you to pass a stereo
pair out of the EDL, to strips 3 and 4 and then through 1 and 2. Finally,
the signal pops out M1/M2. So, it passes through both pan pots, trim
faders and EQ sections. This means that you get twice, yes, twice the EQ of
a single pair of strips. Isn’t that amazing! Remember, the faders and pan
pots are “live,” so it’s best to leave the faders and pans on strips 3 and 4
alone and just mess with those on 1 and 2.

Once all of the audio is as desired, you need to add the Start of Track
(SOT), End of Track (EOT) and Index marks than will define the P and Q
codes on the disc. The best way to start this is to Zoom To Entire Track and
throw away the Gates. Then, select Edited Black To Marks under the Mark
menu. Any SOT or Index marks missing after this process need to be placed
manually.

Manual mark placement is straightforward enough. Marks can be placed
using the left Gate or by dropping the mark on the fly. Segues or PQ splices,
as the Sonic calls them, are situations where the time between an EOT and
the next SOT is less than 1 second. Edited Black To Marks will ignore these
short stretches of edit black so you need to do the marking yourself. Place
the Move Left Gate To Next Edit command will “pull” the left Gate over to
the next black fade’s edit event.
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Always check the marks; their type and placement. By double clicking
on the mark’s “flag,” you open the Mark Info dialog. Here, you can inspect
the mark’s settings and move to the next or previous mark. To make sorting
all those marks easier, use track 1 for SOT/EOT and index marks and place
all other mark types in track 2.

Depending on the model of CD–R or 8 mm tape drive that you have,
you may want to make a CDMI File instead of a direct disc dump. This
feature decouples the image or data creation process from the actual writ-
ing of the data. So, read and write times for a device are of lesser impor-
tance than if everything is done at once.

Another way to get your master to the replicator is to send a DDP or
Disc Descriptor Protocol file, usually on Exabyte tape. You should use the
PM’s DDP PQ verify function before you send off the tape. Also, the
Utilities>CD Play Panel can be enlisted for playing back the tape. The Put
PQ At End of Tape option allows for later addition of ISR codes to an
existing tape but increases the time it takes to perform a verify. Note that
CDMI file creation makes a folder with all mandatory DDP–compliant
files; DDPID, DDPMS, SD and the disc image itself. Each PM “tape” can
have only one CDMI file on it.

The model of CD–R also has bearing on the actual infomation that is
written to the disc. The Sony 920 creates disc that are missing UPC and
ISR Codes. So, the resultant disc is not a perfect vessel for replication.
Many customers are unaware or don’t require either feature, so don’t dispair
if you own a 920.

For complicated EDLs, there’s often an advantage to having, say, six
panels with four as destination and two as source. That way, you can mix
two stereo pairs together for the final product. “Great,” you say, “…alot of
good that does me!” since I’d have to comp or capture down to two tracks
before dumping. But wait, you don’t have to! Simply assign both stereo
pairs to A1/A2, then save and dump the EDL. Sonic will mix on the fly at
single or double speed, DDP tape, disc, whatever.

• Wrapping up
This collection of tidbits covers the bare essentials of mastering on Sonic. As

with most endeavors, quality mastering is a craft that requires critical listening
skills and plain ol’ experience. Critical listening can be learned…so start logging
those hours! And don’t forget, always carry and use hearing protectors…
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• Colophon
Heads are set in the Gill Sans Condensed family. TOC head is Gill San Extra

Bold. Body text is Adobe Garamond. Action items are Zapf Dingbats. The cover
consists of various members of the Rotis family and the Seneschal logo, property
of Seneschal                    ©1999

Thanks for playing!
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